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Abstract

Advances in super-resolution microscopy enable the molecular profiling 
of cells and tissues at the nanoscale level, surpassing the diffraction limit 
of conventional light microscopy. However, super-resolution techniques 
typically require access to expensive specialized equipment and extensive 
training, limiting their broad applicability. Here we provide a detailed protocol 
for combining expansion microscopy with enhanced super-resolution radial 
fluctuations analysis to achieve nanoscale resolution using conventional 
microscopes. Expansion microscopy physically enlarges the sample, while 
enhanced super-resolution radial fluctuations computationally enhances 
the image resolution by analyzing fluorescence fluctuations over time. By 
combining both, we achieve images with a resolution of 25 nm in combination 
with diffraction-limited microscopes. Our step-by-step instructions include 
the expansion of cells and tissue samples, the optimization of multispectral 
microscopy parameters and the implementation of quality control metrics 
to minimize artifacts. We further cover the use of quantitative tools such as 
NanoJ-SQUIRREL, which enable the assessment of resolution improvements 
and image fidelity. We discuss key considerations for each stage, including 
sample preparation, image acquisition, computational processing and 
downstream analysis. Potential pitfalls and troubleshooting strategies are 
also addressed. This protocol can be used for imaging a variety of sample 
types with multiple fluorescent labels. With nanoscale spatial resolution 
and molecular specificity, expansion-enhanced super-resolution radial 
fluctuations microscopy provides a flexible, accessible approach for 
investigating cellular ultrastructure, protein localization and interaction 
networks, suitable for applications in cell biology, histopathology and 
biomedical research. The procedure requires 3–4 d to complete, involving 
~7–9 h of total bench, imaging and processing time and only requires basic 
expertise in tissue handling, molecular and cell biology, and microscopy.

Key points

	• The expansion-enhanced 
super-resolution radial 
fluctuations procedure covers 
molecular sample labeling, 
followed by the expansion 
pipeline (including anchoring, 
polymerization, digestion and 
expansion) and enhanced super-
resolution radial fluctuations 
imaging (including mounting, 
imaging, computational image 
enhancement, image analysis 
and quality control).

	• Alternative methods also 
combine the use of fluorescence-
fluctuations detection algorithms 
with fourfold or tenfold expansion 
microscopy protocols, such as 
Magnify or the resource-intensive 
One microscopy. Expansion-
enhanced super-resolution radial 
fluctuations is advantageous 
for imaging large-scale tissue 
samples such as clinical biopsies.
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Introduction

Deciphering the intricate ultrastructure of cells is crucial for understanding cell biology and 
its implications for health and disease. Super-resolution microscopy (SRM) approaches enable 
molecular profiling at the nanoscale by surpassing the diffraction limit of light, a physical 
barrier limiting the resolution of conventional light microscopy systems to ~250–300 nm. Over 
the past decades, numerous SRM approaches have emerged, including structured illumination 
microscopy1,2, stimulated emission depletion (STED)3 and single-molecule localization 
microscopy4 approaches such as stochastic optical reconstruction microscopy5,6, among 
others7. Despite these groundbreaking advancements, the widespread adoption of SRM in 
biological laboratories and clinical pathology units has been hindered by several challenges. 
These include the requirement for costly specialized equipment, the need for extensive and 
specialized training and, in some cases, limitations in the availability of optimized fluorophores 
for multicolor imaging. Recent efforts have focused on developing alternative approaches that 
are reliable, reproducible, flexible and less reliant on expensive and specialized equipment, 
thereby increasing the accessibility and applicability of super-resolution imaging in diverse 
research settings.

One technology that fits these criteria is expansion microscopy (ExM)8. In ExM, biological 
specimens are embedded in a swellable hydrogel used to isotropically expand specimens in all 
three dimensions, achieving super-resolution with diffraction-limited microscopes (Box 1). The 
original ExM protocols achieved an approximately fourfold unidimensional isotropic expansion 
factor, allowing a lateral resolution of up to 70 nm in biological specimens in combination with 
diffraction-limited microscopes8–10. Since its implementation, other ExM protocols have been 
developed that enable even higher resolutions by enhancing the degrees of unidimensional 
expansion from fourfold to the range of 10–20-fold11–14. However, this comes at the cost of more 
complex handling procedures, a reduced field of view and low signal levels due to the dilution 
of fluorophore density15. As a result, most ExM applications currently rely on well-established 
fourfold expansion protocols, striking a balance between resolution improvement and practical 
usability. The successful application of ExM in the field of life sciences16–19 and additional 
advances, including in the development of novel anchoring strategies14,20,21 and adaptations 
for specific sample requirements22–25, further aided in establishing ExM as a widely accepted 
and flexible methodology for the ultrastructural profiling of biological specimens.

An alternative approach to achieving super-resolution without specialized equipment is 
fluctuation analysis-based computational image enhancement. Among the various techniques 
available26–29, super-resolution radial fluctuations (SRRF)30, and its recently published enhanced 
version eSRRF31, have emerged as versatile and widely adopted methods for live-cell SRM. The 
popularity of (e)SRRF is evident from its extensive use within the scientific community32–38, 
as it can be applied across various microscopy setups using commonly employed fluorescent 
molecular probes39. (e)SRRF enhances the resolution by analyzing a timelapse image series 
through a stepwise process that measures local radial symmetries and temporal fluctuations 
over time. This process ultimately results in reconstructing a single super-resolution image with 
an improved signal-to-noise ratio and a resolution range of 60–150 nm (ref. 30) (Box 2), making 
it compatible with most conventional fluorescence microscopes.

By redefining some of the fundamental reconstruction principles, the new eSRRF 
implementation succeeds in improving image fidelity and resolution and even extends to 3D 
super-resolution in combination with multifocal detection modalities. eSRRF also incorporates 
an automated parameter optimization feature based on quantitative image quality metrics 
for image quality and resolution, enhancing user-friendliness and reproducibility31.

In this context, we recently developed a novel modular super-resolution pipeline 
‘expansion-enhanced super-resolution radial fluctuations’ (ExSRRF)40 that combines the 
principles of ExM and fluctuation-based image processing. Here, we present a detailed 
step-by-step protocol to enable new users without prior experience to quickly adopt this 
technology for nanoscale profiling. We provide an overview of the principal stages and 
experimental timeline (Fig. 1), along with detailed instructions. These step-by-step instructions 
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highlight challenges and provide concepts for troubleshooting, quality control and image 
analysis. While this protocol aims to help users adopt and optimize the ExSRRF workflow, many 
of the aspects discussed in this protocol will also apply to immunofluorescence microscopy, 
ExM and fluorescence fluctuation detection algorithms in general.

Development of the procedure
The ExSRRF method was developed as a versatile and widely applicable pipeline for nanoscale 
profiling of biological specimens. To ensure broad accessibility, we built upon the most 

BOX 1

Expansion microscopy
The first reported protocol for ExM was established by the Boyden 
laboratory in 2015, leveraging the well-established properties of 
certain acrylate-based hydrogels to isotropically swell in contact 
with deionized water8. The ExM approach was proposed as a means 
of enhancing the effective resolution in microscopy by increasing the 
size of biological samples, utilizing a specific gel chemistry resulting 
in a fourfold increase in sample size. The original ExM protocol 
required a customized label, containing a methacryloyl group 
to engage in free radical polymerization, a DNA-oligonucleotide 
capable of hybridizing with a complementary sequence linked to an 
affinity tag and a chemical fluorophore for visualization purposes. 
Subsequent protocols replaced this anchoring and labeling strategy 
with a direct protein anchoring to the gel9,73, eliminating the need 
for customized fluorophores and enabling ExM to be adopted by a 
broad community. Therefore, in its most widely adopted forms, in 
ExM, a fluorescently labeled specimen (1) generally undergoes an 
anchoring treatment (2) to facilitate attachment of biomolecules 
to the hydrogel matrix after hydrogel embedding (3), followed by 
homogenization (4) and incubation in deionized water resulting in 
isotropic sample expansion (5). It is important to highlight that, for 
the sake of illustration, the sizes of the hydrogel mesh and of the 
cells are not true to scale. Of note, in this rapidly evolving field, in 
recent years, several alternative developments have been made, 
expanding upon the widely used fourfold protocols of ExM. These 
include achieving higher degrees of expansion using iterative 
expansion11 or alternative gel chemistries that allow for up to tenfold 
expansion in a single round of expansion12,13, as well as exploring 

novel protein anchoring strategies (including novel chemical14 
and physical74) and alternative gel chemistries to further enhance 
stability and nanoscale precision22.

One critical aspect of ensuring both the quality control and 
the quantitative reliability of the ExM approach is the accurate 
assessment of the expansion factor. While measuring the increase 
in gel size after expansion serves as an important control step—
helping verify that the gelation and expansion procedures have been 
executed properly—this method alone is not a reliable indicator 
of the effective expansion factor at the sample level. The overall 
gel size may expand uniformly, but local variations in the sample 
can result in different effective expansion factors for biological 
structures. To more precisely estimate the effective expansion 
factor, it is necessary to measure features within the sample that 
have a well-characterized and narrow size distribution, such as cell 
sizes or nuclear diameters (as outlined by Heil et al. in their Platelet 
ExM study75). However, even this method is limited by biological 
variability. For truly accurate measurement of the expansion factor, 
a direct comparison of pre- and post-expansion views of the same 
structure is ideal. This allows for direct analysis of the dimensional 
changes8,41. Alternatively, well-defined molecular or synthetic 
structures, such as fluorescent beads or nanostructured grids, can 
serve as internal ‘rulers’, offering a reliable, standardized reference 
for assessing how much the sample has expanded76–79. These 
approaches enable a more quantitative and precise determination of 
the actual expansion factor, ensuring more robust and reproducible 
results in ExM experiments.

Biological
specimen

Primary
antibody

Secondary
antibody

Anchoring
agent

Expandable
hydrogel

Deionized
water

(1) (2) (3)3)(2) ((1) (4) (5)
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BOX 2

The eSRRF principle
SRRF was pioneered by the Henriques laboratory in 2016—recently 
updated to eSRRF—as a novel tool to enable live-cell super-
resolution imaging in combination with conventional microscopes 
to overcome several limitations of SRM in this particular field30,31. 
While single-molecule localization microscopy techniques such as 
stochastic optical reconstruction microscopy rely on the induction 
of photoswitching kinetics of the fluorophores to keep most emitters 
in an off-state and only detect and localize the signals of subsets 
of individual well-separated molecules, eSRRF does not require 
single-molecule blinking.

The eSRRF method, visualized in the figure on the right, generates 
super-resolved images by relying on intensity fluctuations, 
even in cases with dense overlapping emitter signals. Using a 
short sequence of images (raw stack, top left), eSRRF surpasses 
diffraction-limited WF resolution (top middle) and reveals the 
underlying ultrastructure (eSRRF/SRRF, right; scale bars, 2 µm). 
Compared with SRRF, eSRRF achieves superior reconstruction 
fidelity, as quantified by resolution-scaled error (RSE: 13.3 for eSRRF 
versus 19.1 for SRRF).

The approach takes advantage of two basic principles: that 
fluorescent molecules emit radially, and their intensity fluctuations 
are temporally correlated, unlike background noise. To pick up the 
radial emission patterns in each image in the time stack, eSRRF 

magnifies pixels (magnification M = 5) and calculates intensity 
gradients in both the x and y directions (Gx, red; Gy, blue). Using 
a distance-dependent weighting map (Gaussian profile, R = 1.5, 
white arrow), these gradients are converted into a radial gradient 
convergence (RGC) map, which highlights fluorescent molecule 
positions as points of high RGC. The temporal analysis capabilities 
of eSRRF have been substantially refined to accommodate diverse 
imaging scenarios. The temporal average projection (AVG) stands 
as the most reliable approach, demonstrating superior robustness 
against artifacts when dealing with high-density molecular 
environments. This method effectively processes data across varying 
experimental conditions while maintaining reconstruction fidelity. 
For scenarios where fluorophores exhibit pronounced intensity 
fluctuations and are sparsely distributed, higher-order correlation 
analyses through VAR and TAC2 can achieve enhanced resolution. 
However, these approaches demand careful consideration, as they 
are particularly susceptible to noise and can generate significant 
artifacts if the experimental conditions are suboptimal. Finally, the 
sensitivity parameter (S) controls PSF sharpening power in eSRRF. 
More in-depth information can be found in the eSRRF publication31.

Fluctuation analysis techniques such as eSRRF demonstrate 
significant nonlinearity, demanding precise parameter tuning 
to minimize reconstruction artifacts when handling imaging 
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commonly used fourfold ExM protocols8–10 combined with conventional widefield (WF) 
microscopes40, which are among the most readily available fluorescence microscopes in life 
science laboratories. ExM inherently reduces the fluorophore density and overall brightness9, 
and is incompatible with commonly used fluorescence-protective mounting media. To 
overcome these limitations and further enhance resolution, we proposed integrating ExM with 
(e)SRRF imaging. Fluctuation-based image enhancement techniques such as (e)SRRF do not 
require high laser intensities, specialized photoswitching buffers or dedicated microscopes, 
making them well-suited for ExM.

The versatility and applicability of the ExSRRF method was demonstrated and validated in 
a broad range of biological scenarios, tissue types and species in both clinical and experimental 
samples. Examples of its application include neoplastic, neurodegenerative, ischemic and 
autoinflammatory diseases and scenarios. Of note, ExSRRF was successfully applied even 
in challenging tissue types such as placenta tissue and bone marrow. Furthermore, as a 
demonstration of clinical translation and diagnostic applicability, it was demonstrated that 
ExSRRF can detect diagnostic and quantify ultrastructural patterns of disease in human clinical 
biopsies that would otherwise require electron microscopy to be detected.

The image processing of expanded specimens was originally based on the SRRF algorithm40, 
whereas the eSRRF algorithm described here provides an improved framework with higher 
resolution and fidelity, leveraging the same fluctuations-based principles31.

Overview of the procedure
The ExSRRF pipeline consists of a 12-stage procedure where the user starts with the molecular 
labeling of specimens, followed by the expansion pipeline (pre-expansion imaging, anchoring, 
polymerization, digestion and expansion) and then the eSRRF (mounting, post-expansion 
imaging, pre-processing quality control, computational image enhancement, post-processing 
quality control and image analysis). It is noteworthy that in this protocol we focus primarily 
on describing the ExSRRF pipeline in combination with indirect immunofluorescence as a 
molecular labeling approach for proteins, which are among one of the most widely targeted 
classes of biomolecules in ExM and SRM for super-resolved imaging. In addition, we also 
provide information on how to combine ExSRRF with RNAscope-based mRNA detection, one 
example of a widely adopted, robust and commercially available platform for mRNA detection 
in formalin-fixed paraffin-embedded (FFPE) samples. In this context, it is noteworthy that a 
number of other strategies for combining ExM with fluorescence in situ hybridization (FISH) 
have been described that, in principle, are therefore also applicable in the context of ExSRRF, 
for example, ExFISH21, Magnify14 or ChromExM17. It has to be highlighted that many of these 
protocols require either additional anchoring steps, modifications to the hydrogel chemistry 
or both14,17,21. In this rapidly growing field, novel protocols for combining ExM with additional 
classes of biomolecules may emerge in the future. We therefore here chose to focus on 
providing an easy to implement strategy for the detection of proteins and mRNA that requires 
minimal adjustment in combination with the most widely adopted ExM protocol variants9,10. 
The individual stages of the ExSRRF pipeline are described in more detail below.

Of note, since previous protocols on ExM workflows have been published41–44, within this 
protocol we chose to primarily focus on the integration of the expansion workflow into the 
combined approach and on thoroughly explaining the (e)SRRF workflow in combination with 

data from a broad spectrum of microscopy platforms46. While 
the signal nonlinearity introduced by the fluctuation analysis 
prevents quantitative comparison of signal levels, spatial signal 
patterns or distributions can be assessed. To avoid reconstruction 
artifacts, the implementation of stringent quality control protocols, 
anchored in quantitative image quality metrics, is imperative within 
this framework. Ideally, a super-resolved image reconstruction 
allows to achieve the best compromise between both image 

resolution and image fidelity. Both measures can be described by 
quantitative metrics. Image resolution is estimated based on FRC80 
or decorrelation analysis81. To assess image fidelity, local errors 
introduced by image processing can be charted in an error map or 
quantified by the global metric as the RSP coefficient45. This allows 
for example to quantify the image fidelity improvement. In eSRRF, 
this compromise is formulated in the QnR factor based on which 
parameter settings are optimized31.

(continued from previous page)
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sample expansion. Therefore, in the main protocol we only provide a brief overview over the 
labeling and tissue expansion stages. To ensure that users without previous experience in 
sample expansion can fully adopt the protocol without relying on external resources, we have 
incorporated a comprehensive protocol providing further details, including indications of 
hazardous risks, critical steps, tips and additional figures to better illustrate key aspects into 
Supplementary Note 2.

t
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Post-processing quality control
Steps 30–31

Image analysis
Step 32

a

b

c

Fig. 1 | Overview and timeline of the expansion and fluctuations-enhanced microscopy workflow. a, Graphical overview 
of the general workflow. After molecular labeling, tissue specimens are embedded in hydrogel and expanded, followed by 
a time-lapse image acquisition and computational reconstruction using the eSRRF algorithm, resulting in the final super-
resolution image. b, A schematic overview of the individual steps of the workflow c, Experimental timeline of the workflow 
including bench time and total experimental time per day.
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Molecular labeling of specimen (Steps 1–6)
Molecular labeling of biological specimen is the first stage and a critical step to achieving 
high-quality image data. Here, we describe an immunostaining protocol optimized for the 
fluorescent visualization of proteins within clinical and experimental FFPE tissues. However, 
alternative labeling protocols, including alternative immunolabeling protocols or fluorescent 
labeling of RNA may be applicable as well9,10,21,40.

Pre-expansion imaging (Step 7)
Pre-expansion imaging is crucial in the workflow, serving as a key quality control step and 
forming the basis for correlative comparisons between pre-expansion and ExSRRF images. 
Inspecting tissue overviews before expansion helps identify potential artifacts, such as large-
scale tissue distortions and ruptures. Additionally, these overviews provide a broad spatial 
context, help identify regions of interest and assist in accurately assessing biological distances, 
which can be challenging in expanded specimens.

Anchoring (Steps 8–9)
During the anchoring stage, the sample structure is linked to an anchoring agent, allowing 
biomolecules to attach to the acrylamide-based hydrogel for subsequent even expansion of the 
whole specimen. This section provides detailed information on the application of a frequently 
used and robust anchoring agent for protein targets: succinimidyl ester of 6-((acryloyl)amino)
hexanoic acid, often simply referred to as ‘acryloyl-X’. Acryloyl-X integrates into the gel matrix 
via its acrylate group and binds to the primary amines of proteins through its succinimidyl 
ester group, thereby covalently attaching proteins and fluorescently labeled antibodies to the 
gel9. Furthermore, in the troubleshooting section, we discuss alternative agents for protein 
anchoring. It is noteworthy, that different types of biomolecules may require additional 
anchoring strategies. For example, for the attachment of mRNA to the hydrogel, an anchoring 
strategy called ‘Label X’ has been described21. Of note, we found that for some particular 
RNAscope-based FISH kits, such as the RNAscope Multiplex Fluorescent kit, no additional 
anchoring step other than acryloyl-X is required. As the OPAL dyes used in RNAscope covalently 
bind to neighboring tissue proteins, there is no need for an additional mRNA anchoring step40.

Polymerization (Steps 10–14)
During the polymerization stage, the tissue specimen is transformed into a tissue–hydrogel 
hybrid with the ability to expand. After the anchoring treatment, the tissue specimen is initially 
immersed in an activated monomer gelling solution, allowing the hydrogel monomers to 
evenly penetrate the tissue specimen. Since polymerization is a heat-dependent reaction, this 
penetration step is carried out at 4 °C to avoid premature polymerization. After completing the 
monomer penetration, a gelling chamber is assembled around the tissue specimen to provide 
an adequate gel size and thickness that can be consistently reproduced across multiple batches. 
The specimen is then moved to a humidified incubator at 37 °C allowing the monomers to 
polymerize into a solid hydrogel.

Digestion (Steps 15–18)
The digestion stage is essential for achieving artifact- and distortion-free tissue expansion by 
reducing and homogenizing tissue resistance. Inadequate digestion can restrict the maximum 
expansion factor attained and often leads to distortions or ruptures during the expansion 
process.

Tissue expansion (Steps 19–20)
After digestion, the specimen is removed from the slide and transferred to a container for 
incubation in double-deionized water (ddH2O), which results in uniform tissue expansion.

Sample mounting (Steps 21–22)
It is crucial to mount and immobilize the expanded specimen correctly to obtain artifact-
free images. Before mounting the specimen on glass-bottom chamber slides, a coating with 
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poly-d-lysine is applied to promote adhesion and minimize lateral movement during image 
acquisition. Following the coating, expanded specimens are placed on the poly-d-lysine-coated 
slides and then transferred to the microscope for image acquisition.

Post-expansion imaging (Steps 23–24)
The post-expansion imaging stage is a unique part of the ExSRRF workflow that differs 
considerably from most imaging protocols in conventional and expanded specimens. While for 
standard ExM procedures, single images are obtained8, ExSRRF requires the acquisition of a fast 
temporal image series of the region of interest (ROI) to record fluctuations in the fluorescence 
signal and acquire imaging data that allows for subsequent eSRRF processing31. ExSRRF imaging 
of the expanded specimen is compatible with a wide range of microscopy systems, including 
light-emitting diode (LED)- and laser-illuminated WF and laser-scanning confocal microscopes. 
To achieve optimal results, imaging should be performed on an inverted microscope with a high-
numerical-aperture (NA) immersion objective. This system must have sufficient acquisition speed 
of 20 Hz or more to capture fluorescence fluctuations and minimize movement artifacts, which can 
degrade the final image quality and resolution. This consideration is particularly important when 
capturing multichannel images. While WF systems have proven immensely powerful for thin tissue 
sections with ExSRRF, the use of confocal microscopy, and particularly spinning-disc confocal 
systems, is advised for thicker samples to exclude out of focus signal by optical sectioning.

Pre-processing quality control and corrections (Steps 25–26)
Before processing the images using eSRRF, it is crucial to perform pre-processing quality 
control. This should ideally start during image acquisition. The main purpose of this step is 
to identify major artifacts, such as lateral movement within the timelapse image series, which 
could affect the final ExSRRF image quality. We will also cover computational pre-processing 
steps to quantify and address these movement artifacts.

Computational image enhancement (Steps 27–29)
After capturing a series of timelapse images of the enlarged specimen, we proceed with 
computational processing using the eSRRF algorithm. The key factors to consider at this 
stage include fine-tuning the eSRRF parameter settings to achieve the best image quality, 
implementing various strategies to minimize processing time and handling multichannel 
image processing.

Post-processing quality control (Steps 30–31)
Post-processing quality control involves identifying and excluding artifacts through 
comparison of ExSRRF images to conventional images within the same regions, as well as the 
computational detection of processing artifacts through super-resolution quality control 
algorithms (for example, SQUIRREL45).

Image analysis (Step 32)
Ultimately, we discuss various strategies for automated segmentation and automated image 
analysis to obtain quantifiable molecular morphometrics at a nanoscale (‘nanometrics’), 
ranging from the development and application of customized tools to the applicability of 
open-source algorithms and strategies.

Applications of the procedure
The combined expansion and fluctuation analysis-enhanced microscopy is a versatile tool 
that can be applied in various life science applications due to its modular approach. This 
technique has been proven to be adaptable to numerous experimental and clinical scenarios, 
including the study of neoplastic, neurodegenerative, inflammatory, genetic and ischemic 
diseases. Additionally, it has been demonstrated to be compatible with detecting proteins using 
immunofluorescence and mRNA through RNAscope-based FISH. This dual capability enables 
comprehensive analysis of biological samples, enabling researchers to explore the relationships 
between gene expression and protein localization in a single experiment40.
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Alternative methods
The adoption of ExM as a widely accessible SRM tool has spurred interest in combining it 
with other optical and computational SRM methods, leading to novel SRM approaches. A key 
focus has been integrating ExM with fluorescence fluctuations-based SRM algorithms, which 
improve resolution without requiring specialized setups and equipment. So far, several of these 
combined workflows leverage fluorescence-fluctuations detection algorithms26,31,39,46 with both 
fourfold ExM37,40 and tenfold ExM14,36 protocols.

Each of these approaches addresses specific requirements posed by the sample type, 
desired resolution and experimental goals. For example, combining super-resolution optical 
fluctuation imaging with Magnify has been shown to provide enhanced resolution with a 
mechanically sturdy gel that retains nucleic acids, proteins, and lipids without needing a 
separate anchoring step, particularly for tenfold expansion14.

A recent advancement in this field is the one-step nanoscale expansion (ONE) microscopy 
methodology36, which achieves single-digit nanometer resolution through the synergistic 
combination of SRRF with advanced expansion protocols providing greater than fourfold 
expansion, specifically utilizing the X10-ExM protocol12,41. This methodology enables 
unprecedented structural visualization of individual proteins under optimized conditions.

The exceptional resolution capabilities of ONE microscopy stem from two key technical 
innovations. First, it employs advanced expansion protocols that achieve substantially higher 
expansion factors41 compared with conventional ExM approaches8,9, including the ExPath 
protocol10 used in the ExSRRF methodology40. Second, the methodology incorporates extensive 
frame acquisition, collecting up to 4,000 frames per ROI for SRRF reconstruction, which stands 
in marked contrast to the 20–200 frames typically acquired in typical SRRF protocols.

While methods combining fluctuation-based super-resolution with tenfold expansion 
protocols demonstrate superior resolution performance, approaches utilizing fourfold 
expansion protocols, such as ExSRRF40, maintain distinct practical advantages. These 
protocols excel in applications requiring preserved tissue context, such as intact clinical 
biopsies. Furthermore, the reduced frame count acquisition translates to decreased storage 
requirements and faster reconstruction times, making it particularly suitable for large-scale 
tissue analysis applications. The ExPath protocol, which we have extensively validated, remains 
particularly valuable for clinical FFPE sample analysis10.

The selection between these methodological approaches necessitates careful 
consideration of multiple experimental parameters including, but not limited to, the specific 
sample characteristics, required resolution thresholds and the precise nature of the biological 
investigation. This understanding has profoundly influenced our protocol development 
strategy, ensuring adaptability across diverse experimental scenarios while maintaining 
rigorous scientific standards.

Limitations
General limitations and consideration in SRM
Many general considerations that apply to SRM also apply in the context of combined expansion 
and fluctuation analysis-enhanced microscopy. The nanoscale architecture of the specimen 
must be preserved sufficiently to allow for ultrastructural visualization. This includes correct 
sample preparation and optimizing fixation conditions for the imaging targets. To correctly 
label the structure of interest, the molecular labeling approach should ideally have a high 
affinity with little to no off-target effects. In addition, for a biological structure to be fully 
visualized, the target must be sufficiently spatially sampled with fluorophores, which means 
that the labeling density must be optimized. Here, post-expansion labeling approaches can 
benefit from the improved accessibility of targets due to protein decrowding1. Ultimately, the 
structure to be visualized must be within the resolution range of the SRM method47.

Linkage error
Linkage error refers to the systematic offset between the location of the fluorescent probe as 
observed by fluorescence microscopy and the actual position of the target protein introduced 
by the labeling strategy. Indirect immunolabeling via primary/secondary antibody complexes 
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can amount to a spatial offset of 15–20 nm48. This offset’s relevance can become increasingly 
important with SRM technologies whose high resolutions start approaching the size of labeling 
probes. Alternative strategies to potentially reduce linkage error in SRM and particularly in ExM 
include nanobody-based labeling approaches49,50, labeling strategies based around genetic 
modifications of the specimen, including the expression of fluorescent proteins9, self-labeling 
protein tags20,51, grafting of peptide ligands52,53 or in case of expansion-based methods post-
expansion labeling48. Another aspect that must be considered here is the degree of labeling of 
each fluorescent tag. Indirect immunolabeling can result in a higher fluorescence signal simply 
because each secondary antibody usually carries two to five fluorescent markers, while smaller 
tags with degree of labeling close to one will result in lower signal levels54.

Mechanical properties of the sample
One of the main potential sources of error in ExM are the substantial structural alterations 
during the sample preparation and expansion process. This manipulation of the sample 
during sample preparation can potentially lead to distortions or ruptures within the specimen, 
especially if not handled carefully. However, it is important to note that tissue preparation 
methods, including preparation protocols for other SRM methods, are also susceptible to 
distortions or ruptures due to factors such as fixation, embedding, sectioning, mounting, 
permeabilization and handling. The severity of these issues also depends on the sample’s 
mechanical properties and homogeneity. Mechanically tougher samples, such as kidney tissue 
or bone marrow, may pose greater challenges in tissue expansion than mechanically less rigid 
and more homogeneous samples such as single-layered cell cultures55–57. Therefore, to optimize 
sample preparation for SRM and especially for ExSRRF, individual consideration of the sample 
properties may be necessary.

Distortions and ruptures
Imaging approaches strive for accurate representations of the sample ultrastructure, thus 
requiring minimal-invasive sample preparation procedures. Distortions and ruptures that can 
occur during the handling of the cells or tissue specimens and during expansion challenge the 
fidelity of any expansion-based SRM technology. Several strategies exist to assess the extent 
of distortions within ExM images58. Correlative comparisons between the diffraction-limited 
conventional images of the specimen before hydrogel embedding and ExSRRF images can 
help to identify ruptures and distortions on the microscale. However, to assess nanoscale 
ruptures and distortions, a super-resolved view of the pre-expansion ultrastructure has to be 
recorded using alternative super-resolution methods. Based on our experience from correlative 
comparisons of pre-hydrogel-embedded specimen and ExSRRF with both diffraction-limited 
microscopes and other SRM (that is, STED), gross artifacts that potentially interfere with 
biological information can often be sufficiently detected through comparisons with pre-
hydrogel-embedded diffraction-limited microscopes, making pre- and post-expansion imaging 
using conventional microscopes a feasible, practical and valuable quality control step40.

Although ruptures and distortions during the handling process may account for a large 
proportion of artifacts, other mechanisms may also cause alterations in the nano-architecture 
of the gel and tissue. Examples include inhomogeneities of the polymerized gel due to 
interactions with the sample structure or residual moisture during polymerization, mechanical 
heterogeneities of the sample and insufficient homogenization. To our knowledge, however, 
a thorough analysis of the degree to which each factor contributes is currently unavailable.

Selection of fluorescent dyes and proteins
When selecting fluorescent dyes or proteins for ExSRRF their suitability for both, the ExM 
and the eSRRF approach has to be evaluated. The classic 4× ExM protocols are generally 
compatible with many fluorescent dyes and fluorescent proteins. However, the degradation 
of fluorescent markers during the fixation, polymerization and homogenization process is 
an important consideration. For example, the signal quality of endogenous proteins such as 
GFP can be diminished under certain fixation conditions59. Additionally, while endogenous 
ß-barrel fluorescent proteins such as GFP display a high resistance to proteinase K digestion60–62 
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and are, therefore, likely to partially retain their endogenous fluorescence in the process of 
tissue processing9, non-ß-barrel fluorescent proteins are more easily degraded by proteinase K 
digestion62.

While, in principle, most ExM protocols are compatible with a large variety of fluorescent 
dyes, a reduction in fluorophore intensity after secondary antibody staining with a retention 
of 50% brightness compared with the pre-expansion signal is to be expected9. Furthermore, it 
is important to note that cyanine-family dyes such as Cy3, Cy5 and Alexa Fluor 647 show high 
degrees of degradation during hydrogel polymerization9. Atto 647N and CF 633 are commonly 
applied alternatives for the far-red channel as they exhibit good signal retention9,40. To achieve 
an additional resolution enhancement of ExM by fluctuation analysis, it is important to also take 
into account the emission properties of the fluorescent dyes or proteins. Without fluctuations 
in the fluorescence signal, eSRRF processing will not lead to an increase in resolution, 
whereas a high degree of fluorescence fluctuations enables high-quality super-resolved 
reconstructions. Supplementary Table 1 lists the dyes and fluorescent proteins and their 
expected performance in ExM and eSRRF.

Limitation to fixed samples
All expansion-based microscopy approaches are currently incompatible with live-cell imaging 
due to the requirement of fixation and homogenization and the separation of biomolecules63.

Volumetric imaging
Two of the key advantages of standalone ExM are its ability to achieve isotropic expansion 
and resolution enhancement across all three dimensions, as well as the refractive index 
homogeneity of ExM-processed samples, both ideal traits for 3D super-resolution imaging 
of thick specimens. In contrast, eSRRF faces certain challenges for 3D super-resolution 
processing, particularly due to the requirements it places on the detection modality. Achieving 
resolution enhancement in all three dimensions necessitates simultaneous observation of 
fluorescence fluctuations across multiple z-planes. In practise, 3D-SRRF was demonstrated 
using a multifocus microscope, which employs a multifocus grating to project nine focal planes 
onto a single camera, enabling single-shot volumetric imaging31. However, this specialized 
detection system is not commercially available, limiting its accessibility to many researchers. 
Without such an instant volumetric imaging setup, eSRRF can only be applied to 3D datasets in 
a plane-by-plane fashion, improving resolution only in the lateral dimension. With this in mind, 
3D ExSRRF can be implemented in a conventional microscope by acquiring sequences of up 
to 200 frames in each plane before moving on to the next z-position. Special caution has to be 
taken to avoid photobleaching during the z-stack acquisition.

Computational processing
eSRRF is an image processing technique relying on fluorescence fluctuations to reveal super-
resolution information. If insufficient fluctuations are observable in the acquired data, for 
example, because of too long exposure times, eSRRF will not achieve a resolution enhancement. 
Also, the processing is highly nonlinear and can create artifacts, especially in cases of low signal-
to-noise ratios. To identify and avoid artifacts, rigorous quality control based on quantitative 
image quality metrics is recommended. Finally, it has to be emphasized that due to the signal 
nonlinearity introduced by the processing, eSRRF reconstructions can not be used to compare 
signal levels quantitatively, but only to measure spatial signal patterns or distributions.

Experimental design
In the following sections of this protocol, we provide detailed information on how to 
successfully implement the method, including information and guidance on the materials, 
procedure, troubleshooting, and expected results. In this context, quality control is critical 
to ensure the results are interpretable and reliable. For example, it is important to conduct 
biological controls tailored to the experimental requirements, including the addition of 
biological positive and negative controls, as required. Furthermore, in the context of our 
method, specific technical controls should be implemented to avoid tissue-handling artifacts 
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that could interfere with biological interpretation. To address this, the protocol discusses 
various strategies for technical quality control, including thorough comparisons of pre- and 
post-expanded regions of interest and the use of computational quality control algorithms. 
For further details, refer to the respective sections below.

Expertise needed to implement the protocol
This protocol can be implemented by anyone with basic training in biological wet laboratory 
handling and fluorescence microscopy, therefore making it accessible to a broad range of users, 
including laboratory technicians, graduate students or postdoctoral researchers without 
requiring specialized facilities or additional personnel.

Regulatory approvals
No specific regulatory approvals, such as material transfer agreements or ethical permissions, 
are necessary for the basic implementation of this protocol in principle.

Materials

Biological materials and samples
•	 Tissue sections. We exemplify our protocol using ExSRRF images from FFPE kidney 

sections. The corresponding datasets and ethics approvals were published and described 
in the original publication40. As demonstrated, we anticipate that the protocol can, in 
principle, be used with any FFPE tissue type40

•	 Cells of interest. To demonstrate the SRRF/eSRRF principle, we used previously published 
live-cell HiLO-TIRF data of COS-7 cells (American Type Culture Collection cat. no. CRL-1651, 
RRID:CVCL_0224) expressing PrSS-mEmerald-KDEL marking the endoplasmic and DNA-
PAINT microscopy data of immunolabeled microtubules in fixed COS-7 cells (datasets 
published by Laine and Heil et al.31). The cell lines used in your research should be regularly 
checked to ensure they are authentic and are not infected with mycoplasma

•	 Nanorulers. We exemplify photobleaching within our protocol using a time-stacked image 
series of 120 nm Nanorulers from GATTAquant DNA Nanotechnologies as previously 
described and published (datasets published by Kylies et al.40)

Reagents
•	 Acryloyl-X, succinimidyl ester (Invitrogen, cat. no. A20770)
•	 Dimethyl sulfoxide (DMSO) (Invitrogen, cat. no. D12345) 

▲ CAUTION  DMSO is a combustible liquid and skin irritant. Avoid heat, hot surfaces, sparks, 
open flames and other ignition sources. Wear appropriate protective equipment and work 
under a fume hood. Dispose of contents to an approved waste disposal plant.

•	 1× Dulbecco’s phosphate-buffered saline (DPBS) (Gibco, cat. no. 14190094)
•	 Sodium acrylate (Sigma-Aldrich, cat. no. 408220) 

▲ CAUTION  Very toxic to aquatic life. Avoid release to the environment. Collect spillage 
and dispose of contents to an approved waste disposal plant. Wear appropriate protective 
equipment and work under a fume hood.

•	 Acrylamide (Sigma-Aldrich, cat. no. A3553) 
▲ CAUTION  Toxic if swallowed. Harmful in contact with eyes, skin or if inhaled. 
Reproductive toxicity, neurotoxic, and carcinogenic. Wear appropriate protective 
equipment and work under a fume hood. Dispose of contents to an approved waste disposal 
plant.

•	 N,N′-Methylenebis(acrylamide) (Sigma-Aldrich, cat. no. 146072) 
▲ CAUTION  Acute toxicity if swallowed. Harmful in contact with skin. Neurotoxicity, 
potential carcinogenicity, and reproductive toxicity. Wear appropriate protective 
equipment and work under a fume hood.

•	 ddH2O
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•	 Sodium chloride (NaCl; Sigma-Aldrich, cat. no. S7653)
•	 4-Hydroxy-2,2,6,6-tetramethylpiperidine 1-oxyl (4HT) (Sigma-Aldrich, cat. no. 176141) 

▲ CAUTION  Harmful if swallowed. It causes serious eye damage and may cause damage 
to organs (liver, spleen) through prolonged or repeated exposure if swallowed. Wear 
appropriate protective equipment.

•	 N,N,N′,N′-Tetramethylethylenediamine (TEMED) (Sigma-Aldrich, cat. no. T9281) 
▲ CAUTION  Highly flammable liquid and vapor. Harmful if swallowed. Causes severe skin 
burns and eye damage. Toxic if inhaled. Wear appropriate protective equipment and work 
under a fume hood.

•	 Ammonium peroxodisulfate (APS) (PanReac AppliChem, cat. no. A1142,0250) 
▲ CAUTION  May intensify fire. Harmful if swallowed. Causes skin and serious eye irritation. 
May cause respiratory irritation after inhalation.

•	 Proteinase K from Tritirachium album (Sigma-Aldrich, cat. no. P2308)
•	 Tris-(hydroxymethyl)-amino methane (TRIS) (Carl Roth, cat. no. 5429.3)
•	 Ethylenediaminetetraacetic acid sodium salt (EDTA) (SERVA, cat. no. 11280.02) 

▲ CAUTION  Harmful if inhaled. May cause damage to organs through prolonged or 
repeated exposure. Wear appropriate protective equipment and work under a fume hood.

•	 Triton X-100 (Sigma-Aldrich, cat. no. T8787) 
▲ CAUTION  Toxic to aquatic life with long-lasting effects. Harmful if swallowed. Causes 
serious eye damage. Skin irritation. Avoid release to the environment. Collect spillage and 
dispose of contents to an approved waste disposal plant. Wear appropriate protective 
equipment and work under a fume hood.

•	 Poly-d-lysine solution, 1.0 mg/ml (Sigma-Aldrich, cat. no. A-003-E)
•	 ProLong Gold antifade mountant (Invitrogen, cat. no. P36930)
•	 Paraformaldehyde (PFA) (Sigma-Aldrich, cat. no. P6148) 

▲ CAUTION  Flammable solid. It is harmful if swallowed or inhaled. Causes serious eye 
damage. May cause cancer. Wear appropriate protective equipment and work under a 
fume hood.

•	 PFA, 32% wt/vol aq. soln., methanol free (Thermo Scientific Chemicals, cat. no. 047377.9L) 
▲ CAUTION  It is harmful if swallowed or inhaled. Causes skin corrosion and eye damage. 
May cause cancer. Wear appropriate protective equipment and work under a fume hood.

•	 Xylene, Baker Analyzed ACS ( J.T. Baker, cat. no. 8080.2500) 
▲ CAUTION  Flammable liquid and vapor. May be fatal if swallowed and enters airways. 
Harmful if inhaled or in contact with skin. Wear appropriate protective equipment and work 
under a fume hood.

•	 Ethanol 99% denatured (Chemsolute, cat. no. 2212.5000) 
▲ CAUTION  Highly flammable liquid and vapor, causes serious eye irritation. Wear 
appropriate protective equipment and work under a fume hood.

•	 Dako target retrieval solution, pH 9, 10× (Agilent, cat. no. S236784-2)
•	 EnVision FLEX wash buffer, 20× (Agilent, cat. no. K800721-2)
•	 EnVision FLEX antibody diluent (Agilent, cat. no. K800621-2)

Equipment
General equipment and supplies

•	 Fume hood
•	 Laboratory gloves
•	 Safety glasses
•	 Respiratory protection (Filter type P1 or higher)
•	 SuperFrost Plus microscope slides (R. Langenbrinck, cat. no. 03-0060)
•	 Food steamer (any; we used Braun, model Multiquick FS 20)
•	 HybEZ oven (ACD, cat. no. 321720)
•	 HybEZ humidity control tray (ACD, cat. no. 310012)
•	 HybEZ humidifying paper (ACD, cat. no. 310025)
•	 EZ-Batch wash tray (ACD, cat. no. 321717)
•	 EZ-Batch slide holder (ACD, cat. no 321716)
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•	 µ-Slide 2-well glass bottom (Ibidi, cat. no. 80287)
•	 15 ml centrifuge tubes (Sarstedt, cat. no. 62.554.502)
•	 50 ml centrifuge tubes (Sarstedt, cat. no. 62.547.254)
•	 0.5 ml micro tubes (Sarstedt, cat. no. 72.699)
•	 1.5 ml micro tubes (Sarstedt, cat. no. 72.690.001)
•	 2 ml micro tubes (Sarstedt, cat. no. 72.695.500)
•	 Tissue culture dishes for adherent cells (Sarstedt, cat. no. 83.3903) 

▲ CRITICAL STEP  Using nonadherent culture dishes can lead to undesired effects during 
the gel mounting and humidifying step.

•	 Aluminum foil (any; we used Carl Roth, cat. no. 1770.1)
•	 Parafilm laboratory film (Amcor, cat. no. PM996)
•	 Cover glasses No.1, 24 ×24 mm (Marienfeld, cat. no. 0101060)
•	 Cover glasses No.1, 24 ×32 mm (Marienfeld, cat. no. 0101172)
•	 Cover glasses No.1, 24 ×46 mm (Marienfeld, cat. no. 0101202)
•	 Cover glasses No.1, 24 ×55 mm (Marienfeld, cat. no. 0101232)
•	 Forceps (any forceps are applicable; for example, Karl Hammacher, cat. no. HWC 071-10)
•	 Razor blades (any razor blade is applicable; for example, Lutz, cat. no. 43.10)
•	 Paint brushes (any paint brush is applicable; for example, Mucki, model Trigonomic, 

size 2 round, sizes 6 and 8 flat)
•	 Nail polish (any nail polish is applicable)
•	 pH meter (any pH meter is applicable; for example, Mettler Toledo, model 

SevenCompact S210)
•	 StainTray staining system with black lid (Simport Scientific, cat. no. M920-2)
•	 Pipette controller (any pipette controller is applicable; for example, Integra, model 

Pipetboy acu 2)
•	 5 ml, 10 ml, 25 ml, 50 ml serological pipettes (Sarstedt, cat. nos. 86.1253.001, 86.1254.001, 

86.1685.001, 86.1256.001)
•	 Pipette 0.1–2.5 μl (any pipette is applicable; for example, Eppendorf, model Research plus, 

cat. no. 3123000012)
•	 Pipette 0.5–10 μl (any pipette is applicable; for example, Eppendorf, model Research plus, 

cat. no. 3123000020)
•	 Pipettes 2–20 μl, 20–200 μl, 100–1,000 μl (any pipette is applicable; for example, 

Eppendorf, model Research plus 3-pack, cat. no. 3123000918)
•	 10 μl, 200 μl, 1,000 μl pipette tips (Sarstedt, cat. nos. 70.3010.205, 70.3030.205, 

70.3050.205)
•	 3.5 ml transfer pipettes (any; we used Sarstedt, cat. no. 86.1171)
•	 Scissors (any scissors are applicable)
•	 Multipurpose paper cloths (any multipurpose paper cloths are applicable; for example, 

ZVG Multizell, cat. no. 10333-00)
•	 Delicate task wipes (any delicate task wipes are applicable; for example, Kimtech Science, 

cat. no 7558)
•	 Precision wipes (Kimtech Science, cat. no. 7552)
•	 ImmEdge hydrophobic barrier PAP pen (Vector Laboratories, cat. no. H-4000)
•	 600 ml glass beaker (any 600 ml glass beaker is applicable; for example, DURAN, 

cat. no. 211064806)
•	 Magnetic stirrer (any magnetic stirrer is applicable; for example, Phoenix, model 

RSM-10 HS)
•	 Staining jars Hellendhal (Kartell, cat. no. 355)
•	 Staining troughs with lids (Carl Roth, cat. no. H554.1)
•	 Glass inserts for staining trough (Carl Roth, cat. no. H552.1)
•	 Wire hangers for glass staining rack (Carl Roth, cat. no. H553.1)
•	 Analytical balance (Sartorius, model no. Entris II BCE224I-1S)
•	 Precision balance (Sartorius, model no. Quintix 5102-1S)
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Fluorescence microscope
The images presented here were captured using a THUNDER Imager 3D Live Cell and 3D Cell 
Culture (Leica Microsystems) equipped with a 20× objective (NA, 0.40) for low-magnification 
and a 40× objective (NA, 1.10), 63× objective (NA, 1.10) and 100× objective (NA, 1.47) for 
high-magnification imaging.

Data processing and analysis tools/software
•	 Analysis computer: a computer with a Microsoft Windows 64-bit or MacOS operating 

system and Java 8. See ‘Equipment setup’ for hardware requirements
•	 Analysis software: See ‘Equipment setup’ for software setup details

Reagent setup
4% (wt/vol) PFA
For a 4% (wt/vol) PFA solution, dissolve PFA powder in 1× PBS to achieve a concentration of 4%  
(wt/vol). Aid solubilization by stirring, heating to 50–60 °C, and adding up to ten drops of 
1 M NaOH per 500 ml. Aliquoted 4% PFA solution can be stored at −20 °C for at least 6 months. 
Instead of using PFA powder to create the final 4% (wt/vol) PFA solution, alternatively a 
commercially available 32% (wt/vol) PFA stock solution can be purchased, stored safely at room 
temperature (20–25 °C) and diluted with 1× PBS to achieve the final 4% (wt/vol) PFA solution 
used for sample fixation.
▲ CRITICAL STEP  Avoid long-term storage of 4% PFA solution at 4 °C or room temperature as it 
results in PFA degradation and the generation of formic acid, which is toxic and diminishes the 
efficiency of PFA fixation.

Acryloyl-X stock solution (10.0 mg/ml)
Dissolve Acryloyl-X powder in anhydrous DMSO at a concentration of 10.0 mg/ml at room 
temperature, aid solubilization by using a bench-top shaker. Aliquot dissolved Acryloyl-X in 
portions of 15µl at −20 °C for long-term storage. Acryloyl-X can be stored for at least 6–9 months. 
While in general, repeated freeze–thaw cycles of Acryloyl-X solutions should be avoided, we 
encountered no problems reusing Acryloyl-X stock solutions after 1–3 freeze–thaw cycles.

Acryloyl-X anchoring solution (0.1 mg/ml)
Thaw Acryloyl-X stock solution aliquot (10.0 mg/ml) and dilute in PBS to achieve a final 
concentration of 0.1 mg/ml. For the anchoring treatment of a clinical histology section, 
depending on sample size, ~100–200 µl of anchoring solution is required.

Proteinase K aliquot
Dissolve lyophilized proteinase K powder (≥30 units/mg) in ddH2O at room temperature to 
achieve a concentration of 10 mg/ml (300 U/ml), then distribute to aliquots of appropriate 
volume (for example, 150 µl). Proteinase K aliquots can be stored at −20 °C for at least 6 months.
▲ CRITICAL STEP  Avoid freeze–thaw cycles as they may damage Proteinase K, resulting in 
reduced enzymatic activity and suboptimal experimental results.

Digestion buffer
The digestion buffer consists of 50 mM Tris, 25 mM EDTA, 0.5% Triton X-100 and 0.8 M NaCl. 
Titrate the digestion buffer to pH 8. When using 50 mM Tris base to create the digestion buffer 
as described above, the solution generally is expected to be too basic, requiring acidification 
(that is, using hydrochloric acid). Alternatively, a Tris–HCl solution at pH 8 can be used instead 
of Tris base, which generally does not require further pH adjustments, as described elsewhere62. 
The digestion buffer can be stored as aliquots at −20 °C for at least 6 months.

Digestion solution
Acclimate digestion buffer and proteinase K to room temperature, then add proteinase K 
at a concentration of 4–12 U/ml. For most pathology samples, a concentration of 8 U/ml is 
appropriate. Mix using a 1,000 µl pipette tip or a 5 ml serological pipette.
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▲ CRITICAL STEP  Avoid using benchtop shakers as their use may damage proteinase K, resulting 
in reduced enzymatic activity and suboptimal experimental results. Carefully pipette to mix the 
solution instead.
▲ CRITICAL STEP  Always prepare a fresh digestion solution before starting the digestion step. 
Proteinase K activity could diminish over time at 4 °C or room temperature, resulting in reduced 
enzymatic activity and suboptimal experimental results.

Target retrieval solution
Dilute DAKO target retrieval pH 9 stock solution (10×) in ddH2O to achieve a 1×solution. Mix up 
and down using a 50 ml serological pipette until solution is fully mixed.

Agilent wash buffer solution
Dilute EnVision FLEX wash buffer stock solution (20×) in ddH2O to achieve a 1× solution. Mix 
up and down using a 50 ml serological pipette until solution is fully mixed. Make sure not to 
introduce bubbles.

Monomer solution
The monomer solution consists of 1× PBS, 2 M NaCl, 8.625% sodium acrylate, 2.5% acrylamide 
and 0.1% N-N′-methylenbis-(acrylamide). The monomer solution can be aliquoted and stored at 
−20 °C for 1–6 months.
▲ CRITICAL STEP  The quality of sodium acrylate may vary. Low-purity sodium acrylate dissolved 
in water can appear slightly yellow. In this case, it is recommended to switch to a new batch.
▲ CRITICAL STEP  For long-term storage, the monomer solution should be stored at −20 °C 
as prolonged storage at 4 °C may result in accelerated decay and suboptimal results. For 
immediate use, monomer solution should always be handled at 4 °C to avoid premature 
polymerization. We have successfully used batches of monomer solution that were stored 
at 4 °C for several months. However, after prolonged storage (that is, >3–6 months) at 4 °C, 
we noted precipitation within the monomer solution and encountered suboptimal results 
and tissue artifacts. We, therefore, recommend not storing the monomer solution at 4 °C for 
prolonged times but rather thawing fresh aliquots.

4HT stock solution
To generate 10 ml of 4HT stock solution, mix 50 mg of 4HT with an appropriate amount of 
ddH2O until a total volume of 10 ml is reached. The solution can be aliquoted into appropriate 
portions (that is, 1 ml) and stored at −20 °C for at least 4 weeks. Although a short storage period 
is recommended, we found that significantly longer storage times (that is, up to 3–6 months at 4 °C)  
can still yield satisfactory results.

APS stock solution
To generate 10 ml of APS stock solution, mix 1 g of APS with an appropriate amount of ddH2O 
until a total volume of 10 ml is reached. The solution can be aliquoted into smaller portions (that 
is, 1 ml) and stored at −20 °C for at least 2 weeks. Although a short storage time is recommended, 
we found that significantly longer storage times (that is, up to 3–6 months at 4 °C) can still yield 
satisfactory results.

TEMED stock solution
To generate 10 ml of TEMED stock solution, mix 1 ml of TEMED with an appropriate amount of 
ddH2O until a total volume of 10 ml is reached. The solution can be aliquoted into appropriate 
portions (that is, 1 ml) and stored at −20 °C for at least 2 weeks. Although a short storage time is 
recommended, we found that significantly longer storage times (that is, up to 3–6 months at 4 °C)  
can still yield satisfactory results.

Activated gelling solution
The appropriate amount per clinical histology sample is in the range of 200 µl. To generate 
200 µl of the activated gelling solution, mix monomer solution with 4HT, TEMED and APS 
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stock solutions in this order on ice in a ratio of 188:4:4:4 (188 ml of monomer solution, 4 ml of 
4HT, 4 ml of TEMED and 4 ml of APS) to achieve final concentrations of 0.01% 4HT, 0.2% TEMED 
and 0.2% APS in a 1.5 or 2.0 ml Eppendorf safe-lock tube. Briefly vortex the solution to mix the 
individual components.
▲ CRITICAL STEP  The activated gelling solution must be freshly prepared on ice immediately 
before sample incubation. Adding APS as the last component is important as it initiates the 
gel polymerization. In addition, as polymerization is a temperature-dependent reaction, it is 
critical to work on ice to avoid premature gelation.
▲ CRITICAL STEP  The concentration of the inhibitor solution 4HT can be adjusted depending 
on the experimental design, such as the thickness of the biological sample. Thinner sections or 
cultured cells can be penetrated more efficiently by the activated gelling solution. Therefore, 
lower concentrations of 4HT can be utilized in these cases.

Equipment setup
Analysis computer
We recommend performing the image processing and analysis steps on a separate analysis 
workstation (Windows PC or Mac with Java 8) with OpenCL-compatible GPU resources. The 
analysis in this protocol was performed with a MacBook Pro with an Intel Core i9 CPU, 2.3 GHz, 
8 cores, AMD Radeon Pro 5500M GPU and 32 GB RAM and a Windows workstation with an Intel 
Core i9 CPU, 3.0 GHz, 24 cores, RTX NVIDIA 4090 with 24 GB and 128 GB RAM.

Analysis software
Image processing can be performed using ImageJ/Fiji or Python. Both implementations are 
optimized for GPU processing, and while the NanoJ implementations in ImageJ/Fiji might be 
more user-friendly for an easy start64,65, the Nanopyx Python library and notebooks offer a 
pathway to automation and integration into Python-based image processing workflows for 
more experienced users66.

To set up image processing tools with ImageJ/Fiji, download the application (https://imagej.
net/software/fiji/), and unpack it in a location that is not ‘C:\Program Files’ but, for example, 
‘C:\Users\[your name]\.’. Run the application and update via ‘Help > Update ….’. If you are running 
ImageJ/Fiji for the first time, you will have to restart the application and run ‘Help > Update ….’ 
a second time to add update sites (detailed instructions on https://github.com/HenriquesLab/
NanoJ-eSRRF). Add the update sites NanoJ-Core and NanoJ-Squirrel from the list of sites and 
manually add the NanoJ-eSRRF update site with the link ‘https://sites.imagej.net/NanoJ-
LiveSRRF/’ at the end of the list. After running the update and restarting ImageJ/Fiji, all plugins 
should be available in the ‘Plugins’ menu.

For Python-based image processing tools available in the NanoPyx library, you will find 
documentation and tutorials here: https://github.com/HenriquesLab/NanoPyx. All the 
tools used in this protocol are available as NanoPyx Jupyter notebooks (https://github.com/
HenriquesLab/NanoPyx/blob/main/notebooks).
▲ CRITICAL STEP  If you have issues installing or running the applications, check the issues on 
the respective GitHub site or post your own questions. You will find a very helpful and engaged 
bioimage analysis community that is always within reach at https://forum.image.sc/.

Procedure

Molecular labeling of specimen
● TIMING  overnight Bench time: 4 h
Depending on the experimental setup, different labeling approaches may be applicable. In this 
protocol, we focus on describing one robust immunofluorescence-based labeling approach for 
FFPE human clinical and experimental animal specimens.
1.	 Dewaxing and rehydration of samples

Sequentially immerse sections in xylene, ethanol and ddH2O for dewaxing and rehydration.
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2.	 Target retrieval
To perform heat-based antigen retrieval, incubate the specimen in an appropriate heated 
target retrieval solution. Allow the sample to cool down for an appropriate amount of time.

3.	 Hydrophobic barrier
Draw a hydrophobic barrier around the specimen using an appropriate hydrophobic barrier 
pen to contain the reagents in place during the subsequent steps.

4.	 Primary antibody staining
Mix primary antibodies and appropriate buffer in the desired ratio. Then, incubate in a 
humidified container.

5.	 Secondary antibody staining
After primary antibody labeling, remove the primary antibody solution followed by 
subsequent washing steps to remove unbound primary antibody. Next, incubate the 
sections with appropriate secondary antibodies and a nuclear marker in an appropriate 
buffer. Incubate the samples in a humidified container shielded from light. After incubation 
remove unbound antibodies by washing the sample.

6.	 Mounting
Add one drop of mounting solution and carefully place an appropriate coverslip on top of 
the section without introducing bubbles between the coverslip and the sample. (Optional 
stop) Stained and mounted sections can be stored at room temperature for up to 2–4 weeks. 
Protect the samples from light to avoid bleaching.

Pre-expansion imaging
● TIMING  1–2 h
Pre-expansion imaging is an important aspect of the ExSRRF workflow to ensure accurate and 
reliable results and quality control.
7.	 Pre-expansion imaging

Mount the specimen on the microscope, set up the required channels and scan the whole 
tissue specimen at the desired optical magnification. For large samples, it is advised to use 
a low-magnification objective (for example, 10× or 20×) for the overview scan of the whole 
sample, followed by high-resolution imaging of regions of interest (for example, 40× or 63× 
magnification). Use the stitching function to create an overview of the whole tissue section.
▲ CRITICAL STEP  When performing conventional pre-expansion imaging, the optical setup 
should match or come close to the desired imaging settings to allow optimal comparison 
and assessment of the expansion factor.
▲ CRITICAL STEP  We recommend scanning the entire tissue specimen during pre-
expansion imaging as this ensures that the ROI for ExSRRF imaging is captured, allowing 
for correlative conventional and post-ExSRRF comparisons. Whole specimen imaging also 
helps to navigate the specimen and allows to crop larger pieces of tissue before hydrogel 
embedding if necessary.
(Optional stop) Stained and mounted sections can be stored at room temperature for up to 
2–4 weeks. Protect the samples from light to avoid bleaching.
◆ TROUBLESHOOTING

Anchoring
● TIMING  overnight Bench time: 15 min
8.	 Coverslip removal

Remove the coverslip by first immersing the sample in xylene, ethanol and ddH2O to 
remove the nail polish and to soften the mounting media, then carefully insert a razor blade 
between the slide and the coverslip and lift the coverslip (Extended Data Fig. 1).
◆ TROUBLESHOOTING

9.	 Anchoring treatment
Mix the acryloyl-X anchoring solution as described in the ‘Reagents setup’ section and 
pipette an appropriate amount onto the section. Then, incubate the section at room 
temperature overnight in a humidified container shielded from light.
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Polymerization
● TIMING  3 h Bench time: 30 min
▲ CRITICAL  During the polymerization step, the stained tissue sections are transformed into 
a tissue–hydrogel hybrid, ultimately allowing for subsequent tissue expansion. One of the key 
considerations is that the polymerization is a temperature-sensitive reaction: While some steps 
must strictly be carried out at 4 °C to avoid premature gelation, others require incubation at 
37 °C to facilitate gel polymerization.
10.	 Washing off the anchoring solution

Remove the acryloyl-X solution from the tissue section and wash off the remaining 
acryloyl-X solution using 1× PBS.

11.	 Preparation of activated gelling solution
Prepare activated gelling solution on ice as described in the ‘Reagent setup’ section of the 
protocol.

12.	 Gelling solution penetration step
Pipette an appropriate amount of activated gelling solution on the tissue section, 
immediately move samples to 4 °C and incubate them in a humidified container protected 
from light for 30 min (Extended Data Fig. 2a).
◆ TROUBLESHOOTING

13.	 Assembly of gelling chamber
Construct the gelling chamber by placing two coverslips as spacers on each side of the 
tissue section, then lay a third, large coverslip on top of the two spacers.
◆ TROUBLESHOOTING

14.	 Hydrogel polymerization step
Incubate the specimen for at least 2 h at 37 °C in a pre-heated incubator protected from 
light. After completion of the polymerization step, cool down the samples to 4 °C.
◆ TROUBLESHOOTING
(Optional stop) After gelation, sections can be stored in a humidified container, protected 
from light with intact gelling chamber for up to 1 week at 4 °C.

Digestion
● TIMING  4.5 h Bench time: 30 min
During the digestion step the sample is homogenized to enable isotropic expansion in the 
subsequent steps.
15.	 Preparation of digestion solution

Prepare the digestion solution at room temperature as described in the reagent setup by 
mixing the digestion buffer and an appropriate amount of the proteinase K aliquot.

16.	 Disassembly of the gelling chamber and gel trimming
To disassemble the gelling chamber, first carefully lift the top coverslip with the help of 
a razor blade that is inserted into the space between the top and the spacer coverslips. 
Next, remove the spacer coverslips following a similar procedure. After disassembly of 
the gelling chamber trim the sample by removing excess gel laterally of the tissue section 
(Extended Data Fig. 3a,b).
◆ TROUBLESHOOTING

17.	 Incubation
Incubate the sample in digestion solution in a humidified incubator at 60 °C for 4.0–4.5 h. 
Ensure that the digestion solution does not evaporate during the incubation step, that is, by 
placing a piece of Parafilm on top of the tissue section immersed in digestion solution. Refer 
to Extended Data Fig. 3c,d and Supplementary Note 2, step 17 for a detailed description of 
this step.

18.	 Cool down
After incubation, move the tray to 4 °C to allow the sections to cool down. (Optional stop) 
Following digestion, tissue–gel hybrids can be stored in a humidified container with a 
Parafilm cover on top in the dark at 4 °C for several days. As long as the Parafilm fully covers 
the section, no additional buffer or storing solution is required as the Parafilm prevents 
dehydration.
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Tissue expansion
● TIMING  1.5 h Bench time: 30 min

The tissue expansion stage of this manuscript requires careful handling to prevent overall 
sample damage and distortions.

19.	 Removal of the tissue section and placement in the expansion chamber
Carefully separate the tissue–hydrogel hybrid specimen from the slide by carefully 
inserting a wetted razor blade at a sharp angle between the slide and the specimen. Use a 
soft and wet paintbrush to load the tissue onto the razor blade after detaching from the 
slide. Transfer the tissue using the razor blade to a wetted cell culture well with the help of 
the paintbrush.

0

5

10

15

0 300 400 500100 200

Timepoints (frame)

D
rif

t (
pi

xe
l)

a

c

b

d

e f

ExM-SDC

Fig. 2 | Recognizing and troubleshooting ExSRRF-related artifacts. a,b, In Step 23 it is critical to identify expansion-
related ruptures of subcellular structures: here, we see CHO cells in 4× ExM with post-expansion pan- and immune 
labeling (Bodypi-NHS (green), with anti-beta tubulin + Fab Alexa 647 (magenta)), acquired with a spinning disc confocal 
(SDC) microscope (a), and the zoom-in shows discontinuities of the microtubule network (white arrowheads) due to 
insufficient homogenization, leading to ruptures in the structure during the expansion process (b). To avoid resolution 
loss due to motion artifacts, the sample drift should be either corrected with NanoJ-Core in Step 25 or directly in the 
eSRRF processing in Step 29. c, Settings for NanoJ-Core drift estimation. d, Based on cross-correlation, the drift in the x 
direction (black line) and y direction (gray line) and total drift displacement (red line) against the first frame is calculated 
for each frame of the example dataset (WF dataset of immunolabeled microtubules in fixed COS-7 cells published by 
Laine et al.31). e,f, The sample drift observed in e, the example dataset, highlighted here by a temporal color projection 
(color scale in d), can be successfully corrected (d), leading to a nice overlap of the image features throughout the whole 
time series (f ). Scale bars,  20 µm (a,b);  2 µm (f).
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20.	 Tissue expansion
Incubate the tissue–hydrogel hybrid in ddH2O by carefully applying ddH2O to the tissue 
section using an excess amount of ddH2O in relation to the size of the specimen. Then, 
incubate the specimen protected from light in ddH2O at room temperature for 15 min. 
Carefully remove the ddH2O and repeat the procedure of incubating the specimen in fresh 
ddH2O three more times until a total incubation time of 60 min is reached (Extended Data 
Fig. 4a,b).
(Optional stop) The specimen can be stored at 4 °C protected from light for at least 1–2 weeks 
in its expanded state in a humidified container. Despite the storage in a humidified container, 
we advise rehydrating the expanded specimen with a few drops of deionized water every 
other day to prevent dehydration and the introduction of dehydration-based artifacts (for 
example, the introduction of gel ruptures from inhomogeneous dehydration while attached 
to a poly-lysine-coated coverslip). Alternatively, for long-term storage, the expanded 
specimen can be transferred to PBS at 4 °C. Transfer of the expanded specimen to PBS causes 
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the gel to shrink, which is to be expected and does not cause a damage to the specimen. 
After recovery from PBS, the sample can be expanded again safely using deionized water.
◆ TROUBLESHOOTING

Sample mounting
● TIMING  15 min Bench time: 15 min
We here discuss a poly-d-lysine-based strategy for sample mounting and immobilization in 
glass-bottom chamber slides (such as the Ibidi µ-Slide 2-well glass-bottom imaging chambers). 
However, depending on experimental requirements, local setups and expertise, other 
mounting strategies may also be applicable and have successfully been used for mounting 
and immobilizing expanded specimen as well. Examples of alternative sample mounting 
strategies include poly-l-lysine, agarose and superglue62 with or without additional physical 
immobilization strategies such as two-component silicone glue24. For additional mounting 
strategies refer to Supplementary Note 1.
21.	 Coating of imaging chambers

Coat the Ibidi µ-Slide 2-well glass-bottom imaging chambers by fully covering the entire 
bottom surface with an appropriate amount (that is, 1 ml) of poly-d-lysine for 20 min at 
room temperature. After completing the incubation, remove poly-d-lysine and dry slides at 
room temperature or on a heat plate at 37 °C until the surface is dry.

22.	 Sample mounting in glass-bottom chamber
Trim a piece of aluminum foil to a width slightly smaller than the width of the imaging 
chamber slide that will be used for imaging. Next, transfer the expanded specimen from the 
cell culture well onto the trimmed piece of aluminum foil with the help of a soft paintbrush. 
Use the aluminum foil to transfer the specimen to the coated imaging chamber and use a 
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soft paint brush to gently push the specimen off the aluminum foil and into the imaging 
chamber. Carefully remove excess liquid using a thin piece of laboratory paper (Extended 
Data Fig. 4c,d).
(Optional stop) Samples mounted in imaging chambers can be stored at 4 °C, protected 
from light, for several days. However, to avoid dehydration, the samples should be 
rehydrated with a few drops of ddH2O every day. Avoid excess fluid, as this could interfere 
with the poly-d-lysine coating, causing lateral movement during image acquisition.

Post-expansion imaging
● TIMING  2 h
23.	 Identifying the z-plane and creating a tissue overview

Transfer the specimen mounted in the imaging chamber to the microscope and place the 
imaging chamber in the slide holder of the microscope. Select a non-immersion objective 
with a large working distance (that is, a 10× or 20× objective). Grossly adjust the xy-position 
within the microscope so that the objective aligns with the middle of the specimen. Set the 
z-position to a level that is distant from the expected focus plane of the tissue section. Set 
the appropriate imaging channels within the microscopy settings. Activate the fluorescence 
detection and slowly move the z-position toward the sample until the signal appears.
After adjusting the z-position, we recommend creating a tissue overview using a 10× or 
20× objective, either using all channels or a single channel, to visualize identifiable tissue 
landmarks for general orientation.
▲ CRITICAL STEP  We recommend starting to image in the middle of the sample as the 
gel margin does not contain tissue. Initially, we recommend imaging a strongly and 
ubiquitously expressed marker while using sufficient laser or LED power as the signal 
intensity in expanded samples may be lower than expected.
▲ CRITICAL STEP  During the acquisition, the data should be visually inspected to 
identify gross artifacts such as tears, distortions or incomplete structures (Fig. 2a,b and 
Supplementary Fig. 1). This can be achieved by aligning pre- and post-expansion tissue 
overviews. Note that the pre-expansion overview may need to be flipped and rotated to 
match the post-expansion overview (that is, using the imaging software of the microscope 
or third party image analysis software such as ImageJ or FIJI).
◆ TROUBLESHOOTING

24.	 Setting-up image settings and timelapse image acquisition
Change the objective to the higher magnification immersion objective with good NA for 
timelapse image acquisition. First, re-adjust the z-position in case of a z-position offset 
from changing objectives. Next, optimize image acquisition parameters for all channels to 
yield optimal image quality when obtaining single images in each channel. After adjusting 
the imaging parameters, select the ROI and acquire a single reference image that can be 
matched to the pre-expansion image to assess expansion factor and sample distortions. 
Then, select timelapse acquisition within the system software. Set the desired number of 
frames within the ROI and minimize the time in between the acquisition of the individual 
frames to 20–50 Hz. A good initial starting point is either capturing 200 frames or adjusting 
the imaging parameters to acquire a time stack within 30–90 s. Then, proceed with 
acquiring the timelapse image series of the ROI.
▲ CRITICAL STEP  When adjusting image acquisition parameters, in some cases, a slight 
compromise between optimal signal quality and exposure time is necessary as the eSRRF 
algorithm needs the detection of fluorescent fluctuations over time at acquisition rates 
of 20–50 Hz, whose detection can be impaired with low frame rates under 10 Hz. While 
the illumination power should provide high signal levels, signal bleaching and saturation 
should be avoided. Severe signal loss due to bleaching or z-drift cannot be corrected; these 
datasets may need to be discarded. Refer to Step 28 for further information on eSRRF 
parameter optimization.
▲ CRITICAL STEP  For multichannel imaging, proceed as follows: always acquire the full time 
series of one channel before moving to the next, starting with the longest wavelength and 
proceeding to shorter wavelengths (for example, red, orange and green). Some channels, 
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such as nuclear staining, may not be relevant for super-resolution processing. In such cases, 
a good strategy is to capture a single reference image first, then deactivate unnecessary 
channels for timelapse acquisition to optimize both time efficiency and storage capacity.

	 ◆ TROUBLESHOOTING

Pre-processing quality control and correction
● TIMING  2 h
25.	 Correcting movement artifacts

The presence of lateral movements in timelapse image series will generate drift artifacts 
during eSRRF processing. If lateral movement artifacts are observed, an image registration 
for drift correction should be applied. This can be done, for example, with NanoPyx 
Jupyter notebooks (https://github.com/HenriquesLab/NanoPyx/blob/main/notebooks/
DriftCorrection.ipynb)66 or with the ImageJ/Fiji plugin NanoJ-Core (Plugins > NanoJ-Core > 
Drift Correction > Estimate Drift). The drift correction is performed based on image cross-
correlation (Fig. 2c–f). To speed up the calculation, a frame window for ‘Time averaging’ is 
defined. It should be large enough to result in a continuous progression of the drift while 
also picking up on vibrations on smaller timescales. To avoid overestimation of the drift, a 
maximum value (‘Max expected drift’) can be defined while the ‘Reference frame’ should be 
the first frame in the stack. The resulting drift values will be saved in a drift table. To achieve 
optimal results, the drift correction should be directly applied during eSRRF processing 
(Step 28). A test dataset for drift correction can be found here: https://doi.org/10.5281/
zenodo.11518140 (ref. 67).

26.	 Channel registration for multicolor data
In the case of multichannel data an additional channel registration might be required,  
which can also be performed with NanoPyx (https://github.com/HenriquesLab/NanoPyx/
blob/main/notebooks/ChannelRegistration.ipynb) or the ImageJ/Fiji plugin NanoJ-Core  
(Plugins > NanoJ-Core > Registration > Register Channels - Estimate). For channel 
registration, a ‘Reference channel’ has to be chosen onto which other channels are mapped 
and the ‘Number of channels in the dataset’ must be specified. To avoid overestimation, 
a maximum shift value can be defined, as well as the block size (‘Blocks per axis’), the lower  
limit of the similarity (‘Min similarity’) and the degree of blurring (‘Gaussian blur radius’). 
To get started, the use of default values is recommended. Registration results will be 
saved in a results table and can be directly applied by activating the ‘Apply channel-
realignment to dataset’ option or running Plugins > NanoJ-Core > Registration > Register 
Channels - Apply.

Computational image enhancement
● TIMING  1–2 h
27.	 Set up eSRRF

eSRRF is available as ImageJ/Fiji plugin (see the ‘Software setup’ section) and as NanoPyx 
Jupyter notebooks (https://github.com/HenriquesLab/NanoPyx/blob/main/notebooks/
eSRRFandQC.ipynb).
While we recommend eSRRF for super-resolution processing, we still provide alternative 
instructions for steps 27–29 for SRRF processing in Supplementary Note 3.

28.	 Optimizing the image-processing parameters
There are five eSRRF processing parameters (Fig. 3a) that should be chosen with the 		
following rationale:

•	 The magnification parameter should be set based on an estimate of the smallest 
feature size expected to be observed in the sample architecture while taking into 
account the expansion factor. Following the Nyquist criterion, this should result in an 
effective pixel size (raw image pixel size divided by the expansion factor) of half the 
feature size. Considering the resolution power of eSRRF and computation time the 
effective pixel size should not be much smaller than 10 nm. The default parameter is a 
magnification of 5, resulting in 8 nm pixels in the eSRRF reconstruction of the ExM raw 
data with a pixel size of 160 nm and an expansion factor of 4
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•	 The ring radius has the most pronounced impact on the results, and it is directly 
related to the width of the underlying point spread function. Choosing a too-small 
ring radius will create patterning artifacts (Fig. 3b, example A), while too-large values 
result in signal blurring and low-resolution outcomes (Fig. 3b, example B). The default 
parameter is 0.5 pixels

•	 The sensitivity allows you to fine-tune the PSF sharpening power applied. The default 
value is 1, and the optimal setting should be determined in a parameter sweep against 
the ring radius, as described below. Too high values create over-sharpening artifacts 
(Fig. 3b, example C)

•	 The frames per timepoint define the size of the window for the temporal analysis. 
To avoid movement artifacts, the time window should be as short as possible while 
providing enough temporal information for eSRRF reconstruction. A good practice is 
to test reconstruction quality with 50 frames, 100 frames, 150 frames and 200 frames. 
The reconstruction quality will saturate at large temporal window sizes and the 
shortest window close to the maximum quality score should be chosen

•	 Vibrations or sample drift can be compensated during eSRRF processing by activating 
the ‘vibration correction’ option (Supplementary Fig. 2)

•	 In eSRRF, different temporal analysis strategies can be activated as eSRRF 
reconstructions. The default is the ‘AVG’, a reconstruction based on temporal 
averaging. This will yield in the best reconstruction results for most datasets. In 
the case of datasets that display sparser blinking patterns, more similar to a single 
molecule localization microscopy dataset, higher order reconstructions such as ‘VAR’ 
or ‘TAC2’ can yield better results. However, these reconstruction modes are also more 
prone to create artifacts and have to be used with rigorous quality control31

While magnification and frames per timepoint can be estimated based on the experimental 
conditions, other parameters should be optimized based on a parameter sweep. For this 
purpose, eSRRF has an automated function that allows to directly quantify resolution and 
fidelity of the different reconstructions and compare the performance based on the quality 
and resolution (QnR) score (Fig. 3c,d). The parameter sweep is performed with NanoJ-
eSRRF (Plugins > NanoJ-eSRRF> eSRRF – Parameter Sweep) (Fig. 3c). To reduce processing 
time, perform the optimization procedure on a representative crop region of the raw data 
image stack (for example, 100 × 100 pixels). The sweep output will be an image stack of all 
reconstructions and sweep maps of the resolution (Fourier ring correlation (FRC) map) 
and fidelity values (resolution-scaled Pearson (RSP) map). The best compromise between 
resolution can be identified as a maximum in the QnR map that is calculated based on the 
sweep outputs (Plugins > NanoJ-eSRRF> eSRRF – Get QnR map from sweep output; Fig. 3d). 
The eSRRF reconstruction with the optimal processing parameters identified in this way 
yield in a high-quality reconstruction providing good image resolution and image fidelity 
at the same time (Fig. 3b, example D).
▲ CRITICAL STEP  To identify optimal reconstruction parameter settings with the 
parameter sweep, it has to be performed in the right parameter range. An indicator that 
the range is not optimal is if QnR maximum is located at the edge of the sweep map. If this 
is the case, adjust the range and rerun the sweep. It is also important to visually inspect 
and compare the reconstructions as a control. This will be much easier if the contrast of 
the stack of eSRRF reconstructions is normalized (Plugins > NanoJ-eSRRF> eSRRF Tools > 
Reset stack for display…). For training purposes, we are providing a training manual with 
test datasets and parameter recommendations here: https://zenodo.org/doi/10.5281/
zenodo.11518140 (ref. 67).

29.	 eSRRF processing
	 Based on the optimal parameter set identified in the parameter sweep (Step 28) the full 

raw dataset is processed. For each dataset you will get a WF and a super-resolved eSRRF 
reconstruction. As mentioned above all of this can also been done with the NanoPyx 
implementation, detailed instructions are found in the training manual (https://doi.org/ 
10.5281/zenodo.11518140)67. Consider batch processing to automate the image 
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reconstruction, for example, via ImageJ macro scripts (https://github.com/HenriquesLab/
NanoJ-eSRRF/wiki/Batch-processing).

	 ▲ CRITICAL STEP  To accurately measure absolute distances and perform quantitative 
image analysis, it is essential to define the correct pixel size based on the effective 
magnification in the final image reconstruction (Image > Properties). This involves 
calculating the correct pixel size by dividing the original pixel size by the measured 
expansion factor. Adjusting the pixel size in this manner ensures that any measurements or 
analyses reflect the true, scaled dimensions of the sample post-expansion.
◆ TROUBLESHOOTING

Post-processing quality control
● TIMING  1 h
30.	 To exclude gross artifacts and ensure the preservation of the expected structure in the 

expanded sample, it is good practice to conduct a comparative analysis of correlative 
pre- and post-expansion images. For this, images acquired in a few selected regions before 
expansion (Step 7) and ExSRRF reconstructions of the same sample areas are compared. 
Measuring representative distances and feature sizes in the image pairs also allows 
calculating the effective expansion factor.

31.	 Identifying processing artifacts and assessing processing performance
	 The computational detection of processing artifacts is performed based on super-

resolution quality control algorithms. Based on the WF and super-resolved eSRRF image 
pair, NanoJ-SQUlRREL allows the calculation of an error map highlighting low-fidelity 
regions where reconstruction artifacts have been created by the processing (Plugins > 
NanoJ-SQUlRREL > Calculate Error-Map, RSE and RSP) (Fig. 4a–c). The achieved resolution 
enhancement should be assessed with the ImageJ Decorrelation Analysis plugin (https://
github.com/Ades91/ImDecorr) by processing both the WF and the eSRRF reconstruction 
(Fig. 4d,e). Local changes in resolution are mapped based on FRC with NanoJ-SQUIRREL. For 
this, two independent eSRRF reconstructions of the same region are required. To generate 
this independent reconstruction, split the raw data into even and odd frames (Plugins > 
NanoJ-SQUlRREL > Tools > Split sequence into odd and even frames) and process both with 
the desired eSRRF parameters. Based on an image stack containing both reconstructions 
the FRC map is calculated (Plugins > NanoJ-SQUlRREL > Calculate FRC-Map) (Fig. 4f). 
The same procedure can also be performed with NanoPyx Jupyter notebooks (https://
github.com/HenriquesLab/NanoPyx/blob/main/notebooks/SRMetrics.ipynb). A step-
by-step guide with examples can be found in the training manual (https://doi.org/10.5281/
zenodo.11518140)67.

Image analysis
32.	 Depending on the context and the target of the experiment, it may be of interest to 

identify fine ridge-like structures in the processed images, for example, membranes of cell 
organelles, vessel networks or the renal slit diaphragm. This can be accomplished with a 
multistep computational approach that leverages the scikit-image software package68. 
Briefly, the computational analysis consists of the following steps:

•	 The ROI, that is, the portion of the image containing the target structure, should 
be identified and isolated either through manual cropping of the image or through 
automatic image processing. A Jupyter notebook with Python code to extract the ROI 
from an endoplasmic reticulum-specific staining is available through GitHub at https://
github.com/imsb-uke/exsrrf_analyses/blob/main/ridges_er_stress.ipynb

•	 Following restriction to the ROI, ridge-like structures can be identified through the use 
of ridge detection filters contained in the scikit-image software package68, including 
filters based on the algorithms described by Meijering69, Sato70 and Frangi71. Ridge 
identification may be improved by thresholding the filter output, restricting the range 
of admissible object sizes to match the expected biological structures, and applying 
morphological operations, for example, opening, closing, dilation or erosion, to 
correct for imprecisions in the segmentation
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•	 Based on ridge detection, several possible quantifications can be computed, including 
the density of the target structure, either globally within the ROI, within a given area or 
in the neighborhood of each pixel using a sliding window approach. Furthermore, the 
Euclidean distance transform can be employed to calculate the distance to the nearest 
ridge for all background pixels to identify areas with high inter-ridge spacing. Similarly, 
examining the distribution of the local densities and the distance to the nearest ridge 
provides a measure for the spatial uniformity of the structure of interest. A Jupyter 
notebook with exemplary Python code can be accessed at https://doi.org/10.5281/
zenodo.11518140 (ref. 67)

Troubleshooting

Troubleshooting information can be found in Table 1

Table 1 | Troubleshooting table

Step Problem Possible reason Solution

7 Slide scanning and 
stitching is not possible

The microscope does not have 
a slide scanning and stitching 
function

Manually scan the entire section at a reasonable resolution with overlapping edges, then use a 
third-party tool for image alignment
Several computational open-source tools exist for the alignment of multitile image datasets for 
different platforms. Examples include ‘BigStitcher’ (Fiji based) and ‘multiview-stitcher’ (Python 
based/Napari). Detailed information regarding instructions and support can be found on the 
respective GitHub pages
https://imagej.net/plugins/bigstitcher/
https://github.com/multiview-stitcher/napari-stitcher?tab=readme-ov-file
https://github.com/multiview-stitcher/multiview-stitcher

8 Coverslip does not 
detach

Nail polish and mounting 
medium firmly attach 
coverslip to slide

Repeat the incubation in xylene for a prolonged time period. Coverslips may become harder 
to remove after longer mounting times. For example, when using Prolong Gold as a mounting 
medium, removing the coverslip after 1–2 d of mounting may not require any xylene, but after a 
time of 4–6 weeks, a prolonged incubation in xylene may be necessary
Use a razor blade to carefully remove the nail polish after xylene treatment
Insert a razor blade on the edge of the coverslip to carefully mobilize the coverslip as much as 
possible, then repeat incubation in xylene. These steps can be repeated several times until the 
coverslip is completely detached

12 Gelling solution 
prematurely forms a 
solid hydrogel

Cold chain of the gelling 
solution was interrupted
4HT inhibitor solution was 
too old
4HT inhibitor solution 
concentration was too low

The gelation is a temperature-dependent reaction. Interruptions in the cold chain can 
initiate unintended gel polymerization resulting in premature gelation. Strictly prepare the 
gelling solution on ice. Consider pre-chilling the pipette tips by placing them at −20 °C to 
4 °C ~30 min before use. Pre-chill the tissue slides by placing them at 4 °C ~30 min before 
adding the gelling solution. Limit all work at room temperature to a minimal amount of 
time (<5 min)
Old or insufficient concentrations of the 4HT inhibitor solution can contribute to an accelerated 
polymerization. Prepare fresh 4HT solution
Use a higher concentration of the 4HT solution (i.e., 1.5× amount). When using higher 
concentrations of 4HT solution, longer polymerization times may be required62

13 Spacers slide inward Spacers start to float in gelling 
solution

If spacers slide inward use forceps to re-adjust the spacers, then apply slight pressure to 
reinforce their position. Make sure to carefully assess the correct position of the gelling 
chamber spacers before starting polymerization step. Displacement of the spacers with 
superimposition onto the tissue section causes insufficient gel thickness, leads to gel instability 
and therefore interferes with tissue expansion
An alternative solution to this problem could be to carefully attach the spacers to the slide using 
superglue, thereby preventing movement of the spacers. This strategy could safely immobilize the 
spacers, preventing them from sliding inward but has the downside that the spacers may be more 
difficult to remove, making the disassembly of the gelling chamber (Step 16) more challenging

13 Air bubbles trapped 
inside gelling chamber

Air bubbles are not in direct 
contact with the sample
Air bubbles are in direct 
contact with the sample

No action needed. Air bubbles that are not in direct contact with the sample can be ignored as 
they do not interfere with the formation of the tissue–hydrogel hybrid
Air bubbles that are in direct contact with the sample will interfere with the formation of the 
tissue–hydrogel hybrid and result in loss of tissue section in the area of the bubble. Move air 
bubbles sideways by either gently moving the top coverslip, gently pressing on top of the 
coverslip using laboratory forceps, forcing the air bubble to move laterally, or carefully adding 
activated gelling solution from one side of the gelling chamber
If these steps fail to work, carefully remove the top coverslip, add new gelling solution and 
reassemble the gelling chamber by adding the top coverslip without introducing bubbles
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Step Problem Possible reason Solution
14 Incomplete gel 

polymerization
Degraded gelling solution
Insufficient sodium acrylate 
quality

If it is suspected that the gelling solution aliquot may have been degraded, thaw and use a new 
aliquot of gelling solution
If this fails, preparing a new batch of gelling solution can be a useful next step. In our 
experience, the expansion method used in this paper is robust. While we have successfully used 
gelling stock solution that was stored at 4 °C for prolonged periods (i.e., several months) we do 
not recommend this procedure as we noted artifacts and reduced gel stability after prolonged 
periods of storage at 4 °C
We therefore recommend storing the gelling stock solution at −20 °C for 1–6 months and 
thawing a fresh aliquot for each experiment
Before preparing a new batch of gelling stock solution, the sodium acrylate quality should be 
assessed by making a sodium acrylate stock solution (38 g/100 ml) and examining the color62. 
The stock solution should be fully transparent and colorless. If a yellow tint is noted, discard the 
sodium acrylate batch and do not use it for the preparation of the gelling solution

16 Top coverslip breaks 
during gelling chamber 
disassembly

Top coverslip is lifted too 
quickly

If the top coverslip breaks, remove the broken part, dispose of in a suitable container and 
carefully start the process of coverslip removal from the opposing side. In general, use as 
little force and work as slowly as possible when deconstructing the gelling chamber to avoid 
breakage of the coverslips

20 Gel expands 
inhomogeneously

Insufficient homogenization When using an alternative homogenization method (i.e., thermal homogenization) consider 
switching to a more potent homogenization such as proteinase K-based digestion as described 
in this protocol
When encountering signs of insufficient digestion using proteinase K as described in this 
protocol, use a new aliquot or batch of proteinase K
If problems still persist, consider increasing the proteinase K concentration, i.e., from 8 U/ml to 
12 U/ml
If problems still persist and proteinase K batch effects are ruled out, variations of the digestion 
buffer to enable higher proteinase K stability buffer by eliminating EDTA and providing a higher 
Ca2+ concentration have been described12,41: 50 mM TRIS, 800 mM guanidine HCl, 2 mM CaCl2 
and 0.5% (vol/vol) Triton X-100 in ddH2O, with the pH adjusted to 8.0

20 Gel is sucked into the 
pipette

Direct contact of the hydrogel 
with the pipette tip of a pipette 
that creates a strong negative 
pressure

Avoid direct contact of the hydrogel with the pipette tip
Additionally, use pipettes with a low negative pressure such as Pasteur pipettes or electrical/
serological pipettes at the lowest settings. Pipettes that create a strong negative pressure 
(particularly 1,000 µl pipettes) can easily suck in the hydrogel into the pipette tip and destroy it 
upon direct contact. This is complicated by the fact that expanded hydrogels in ddH2O are hard 
to see due to their high transparency. We therefore recommend using alternative pipettes with 
lower negative pressures and to work slowly. In addition, the pipette tip should face the bottom 
or the lateral wall of the well when removing ddH2O to further reduce the risk of damaging the 
hydrogel

23 Sample cannot be 
located under the 
microscope

Sample flipped in the z axis Carefully unmount the sample, rotate 180° in the z axis and remount with the help of a 
paintbrush and aluminum foil. During the expansion process samples can accidentally flip 180° 
in the z axis. Imaging of flipped samples may be impossible if the gel thickness exceeds the 
working distance of the objective and overall yield suboptimal imaging results

23 Gross tissue artifacts 
(i.e., ruptures, 
breakages, tears or 
distortions)

Overfixation using a 
crosslinking agent
Problems with anchoring 
treatment
Problems with polymer 
network
Insufficient homogenization
Rough sample handling

Use less harsh crosslinking agent for fixation (i.e., PFA instead of glutaraldehyde). If overfixation 
is assumed, use less strong PFA fixation. Consider using a non-crosslinking fixation agent 
(i.e., methanol)
Use new aliquot of acryloyl-X. Consider changing the pH from neutral (7.4) to more alkaline 
(i.e., pH 10) to enhance NHS reactivity
Consider switching to an alternative anchoring agent (i.e., MA-NHS)
Consider using a fresh aliquot or prepare fresh gelling solution. Check sodium acrylate quality
Avoid multiple freeze–thaw cycles of PrK aliquots. Consider optimizing PrK buffer (increased 
concentration of Ca2+ in the buffer may enhance the PrK activity). This can be achieved by 
lowering the EDTA content of the buffer41. Consider changing to a new batch of PrK
Carefully avoid rough sample handling

24 Poor or no fluorescence 
signal

Poor labeling quality
Fluorophore degradation

Carefully check the pre-expansion imaging signal to confirm labeling specificity and fidelity
Validate that the fluorophores used in the experiment are compatible with the expansion 
process. Refer to Supplementary Table 1 for further information on the compatibility of 
fluorescent dyes, probes and proteins

24 Signal drops or is lost 
during acquisition

Photobleaching Minimize exposure of samples to room light and avoid overexposure to high levels of 
microscope illumination during z-axis localization and sample imaging (reduce number of 
frames and illumination power)
In the case of 3D imaging, the sample is exposed for the full duration of the z-stack acquisition, 
leading to an accumulation of photobleaching. If a loss of sample signal is visible across the 
z-stack, reduce the number of images acquired in each z-plane and the illumination power
If photobleaching can not be sufficiently counteracted by adjusting the acquisition parameters, 
a fluoroprotective additive to the mounting media can be considered. Additives, such as 
sucrose, will reduce photobleaching while also leading to ~10% gel shrinkage72. Supplementary 
Fig. 3 demonstrates the effects of photobleaching, and the respective practice dataset can be 
found at https://doi.org/10.5281/zenodo.11518140 (ref. 67)

Table 1 (continued) | Troubleshooting table
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Timing

Completing all stages of the ExSRRF protocol requires ~3–4 d in total and involves ~7–9 h of 
bench, imaging and processing time. However, it has to be noted that, in particular, the imaging 
and processing time can be highly variable depending on sample size, experimental setup and 
question, image acquisition speed of the microscopy system, hardware-based computational 
processing speed and degree of automatization. Of note, the preparation of some stages/steps 
can be performed in parallel to optimize time management that we have highlighted within the 
protocol. In addition, the pre-expansion immunostaining and imaging can be done several days 
or weeks in advance, which could further facilitate time management.
Steps 1–6, molecular labeling of specimen: can be performed overnight and require ~4 h of 
bench time
Step 7, pre-expansion imaging: requires ~1 h of imaging time depending on sample size
Steps 8–9, anchoring: can be performed overnight and requires ~15 min of bench time
Steps 10–14, polymerization: requires ~3 h and 30 min of bench time
Steps 15–18, digestion: requires ~4.5 h and 30 min of bench time
Steps 19–20, expansion: requires ~1.5 h and 30 min of bench time
Steps 21–22, sample mounting: requires ~30 min and 15 min of bench time
Steps 23–24, post-expansion imaging: requires ~1 h but can be highly variable depending on 
sample size and overall experimental design
Steps 25–32, pre-processing quality control, computational image enhancement post-
processing quality control and image analysis: requires ~1–2 h but can be variable depending on 
sample size, degree of automatization and overall experimental design

Step Problem Possible reason Solution

24 Movements during 
image acquisition

Excess water around the 
expanded sample in imaging 
chamber
Insufficient coating of the 
imaging chamber
Temperature variations
Hydrogel shrinkage due to 
sample dehydration
External sources of vibration

Carefully remove excess water around the expanded sample in imaging chamber using 
laboratory paper to minimize lateral movement
Coat imaging chambers with poly-d-lysine. Overused poly-d-lysine can yield suboptimal results. 
In addition, the effect of poly-d-lysine coating fades away over time so ensure that the slides 
have been coated no more than a few days in advance
Equilibrate sample to the system and room temperature as changes in temperature can cause 
micromovements within the expanded hydrogel
Keep samples hydrated by carefully applying a few drops of deionized water on top of the 
specimen to avoid shrinkage of hydrogels, especially during longer image acquisitions
Minimize external sources of vibration such as opening and closing of doors to the room as 
much as possible

29 Achieved resolution is 
insufficient

Optical aberrations due to 
refractive index mismatch
No sufficient fluorescent 
fluctuations observed
Blurring due to movement 
artifacts

A mismatch in refractive index can cause spherical aberrations when imaging deep within a 
sample, reducing image quality. To prevent this, use a water-immersion objective or adjust 
the refractive index of the gel to match that required for an oil-immersion objective. One way 
to do this is by adding sucrose to the gel, as suggested by Gao et al.72. However, note that this 
adjustment may slightly reduce the gel’s expansion factor
Fluctuation frequency might not to be picked up due to long exposure time. Reduce the 
exposure time, if possible
Consider using a fluorescent marker exhibiting a higher degree of fluctuations
If blurring due to movement artifacts cannot be sufficiently corrected by applying vibration 
correction during eSRRF analysis or drift correction in a pre-processing step, minimize 
vibrations and drift by making sure the microscope and sample are well isolated, avoiding 
mechanical tensions in the sample holder and equilibrating thermal gradients before imaging

29 Very long processing 
times

Very large images
Frame window too long
Magnification is set too high
Computation not speed 
optimized

Reduce the image size by cropping out empty areas or cutting the image down to relevant 
regions of interest
Reduce the number of frames for eSRRF reconstruction if possible. In the eSRRF parameter 
sweep, it is also possible to test eSRRF performance for different frame windows and identify 
the minimum number of frames required for optimal reconstruction results
If it is possible, reduce the magnification parameter
Run on hardware that allows to take advantage of GPU acceleration and make sure to use the 
fastest processing unit in the eSRRF advanced settings

Table 1 (continued) | Troubleshooting table
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Anticipated results

By following all steps in the protocol carefully, after a fourfold isotropic expansion of biological 
samples followed by fluorescence fluctuation analysis, a final resolution in the scale of 25 nm can 
be achieved in combination with diffraction-limited microscopes such as WF40 and confocal37 
while maintaining the sample architecture and minimizing overall artifacts such as breaks, 
ruptures, distortions and reconstruction artifacts. The stepwise increase in resolution from 
diffraction-limited microscopy to ExM to the combined approach described in this paper as 
well as the overall expected data quality when imaging tissues using expansion and fluctuations 
enhancement of conventional LED-based epifluorescence microscopes is illustrated in Fig. 5. 
Here, the renal slit diaphragm is comparatively visualized with diffraction-limited microscopy, 
ExM and combined expansion and fluctuations enhancement. While diffraction-limited 
microscopy fails to provide adequate resolution to resolve the renal slit diaphragm, ExM already 
provides a resolution improvement for structures such as the slit diaphragm that cannot 
be resolved using conventional diffraction-limited microscopy. Ultimately, the combined 
expansion and fluctuations-enhancement approach (ExSRRF) further enhances the resolution, 
significantly contributing to a clearer view of the structure (Fig. 5a), delivering visual results 
comparable to advanced SRM techniques such as STED (Fig. 5b). Additional examples to further 
showcase the resolution range are demonstrated in Supplementary Fig. 4.

A visualization of artifacts that may be encountered is displayed in Fig. 2. Given the modular 
approach of this combined expansion and fluctuations-enhancement approach, artifacts due 
to tissue expansion as well as due to fluorescence fluctuation analysis can arise. Commonly 
encountered artifacts in ExM include the introduction of ruptures and breaks within the sample 
(Fig. 2a,b), which are further discussed within the troubleshooting section of the manuscript. 
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Fig. 5 | Anticipated results. a, Stepwise increase in resolution from WF to ExM to ExSRRF in human kidney tissue stained 
with nephrin to resolve the kidney slit diaphragm. Scale bar in the overview image, 5 µm, scale bars in the areas, 70 nm. 
b, Comparison between ExSRRF and STED in human kidney tissue stained with nephrin. Scale bars, 100 nm. Figure 
adapted from ref. 40 under a Creative Commons license CC BY 4.0 (https://creativecommons.org/licenses/by/4.0/).
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Besides rough tissue handling that may introduce artifacts, it is important to recognize that 
suboptimal anchoring and digestion processes are important sources of expansion-related 
artifacts and that these steps rely on chemical reactions that never achieve perfect efficiency. 
This is especially important in the context of a large variety of different biological sample types. 
For example, it is to be expected that a rigid FFPE clinical pathology sample may chemically and 
mechanically react differently than a single layer of fixed cells.

Besides expansion-induced artifacts, another important cause is sample movements during 
timelapse image acquisition that interfere with the fluorescence fluctuation detection (Fig. 2e). 
In our opinion, the best strategy here is to avoid lateral sample movements by optimizing the 
mounting and imaging conditions as discussed in the troubleshooting section. In case sample 
movements cannot be avoided, we recommend computational recovery of sample drifts before 
or during fluorescence fluctuation processing (Fig. 2c–f). Based on our experience, when 
mounting was performed as described here, sample drifts are rare and computational recovery, 
if required, is generally successful40, making expansion and fluctuations-enhanced microscopy 
a robust, powerful, and flexible microscopy tool in life sciences to enhance the resolution 
of diffraction-limited microscopes, which has recently increasingly been recognized by the 
scientific community14,36,37,40.

Reporting summary
Further information on research design is available in the Nature Portfolio Reporting Summary 
linked to this article.

Data availability
The main datasets were published in the original publication40. Test datasets are available via 
Zenodo at https://doi.org/10.5281/zenodo.11518140 (ref. 67).

Code availability
The code used and described in this paper is available via Zenodo at https://doi.org/10.5281/
zenodo.11518140 (ref. 67) and GitHub at https://github.com/HenriquesLab/NanoJ-eSRRF and 
https://github.com/HenriquesLab/Nanopyx. Additional advice on how to use it can be obtained 
from the corresponding authors upon reasonable request. A Jupyter notebook with Python 
code to extract the ROI from an endoplasmic reticulum-specific staining is available through 
GitHub at https://github.com/imsb-uke/exsrrf_analyses/blob/main/ridges_er_stress.ipynb. 
A Jupyter notebook with exemplary Python code can be accessed via Zenodo at https://doi.org/ 
10.5281/zenodo.11518140 (ref. 67).
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Extended Data Fig. 1 | Coverslip removal. a. Graphical explanation of coverslip 
removal. Stained and mounted sections (Step 8.1) are immersed in xylene 
followed by ethanol (Step 8.2) to remove nail polish and soften the mounting 
media to facilitate coverslip removal. Next, a razor blade is carefully inserted 
between the coverslip and slide at the edge of the coverslip (Step 8.3) and slowly 

angled and moved forward (Step 8.4) to separate the coverslip and slide. The 
remaining mounting media is washed off with PBS (Step 8.5). In case the coverslip 
can’t be separated from the slide consult the instructions in the Troubleshooting 
table - Step 8, such as repeating the xylene incubation. b. Foto examples of the 
respective steps.

http://www.nature.com/NatProtocol
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Extended Data Fig. 2 | Gelling solution penetration and assembly of the 
gelling chamber. a. Graphical explanation of the monomer penetration step 
and the gelling chamber assembly. Activated gelling solution is pipetted onto 
the tissue section to allow for penetration into the tissue section, as well as 
laterally of the tissue section to facilitate the attachment of the gelling chamber 

spacer glasses (Step 12). After completion of the incubation at 4°C, the gelling 
chamber is assembled by placing two coverslips as spacers laterally of the tissue 
section (Step 13.1, 13.2) followed by a third, larger coverglass on top of the tissue 
section and the spacers (Step 13.3) fully covering the tissue section and without 
introducing bubbles (Step 13.4). b. Foto examples of the critical steps.

http://www.nature.com/NatProtocol
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Extended Data Fig. 3 | Gelling chamber disassembly and digestion setup. 
a. Graphical explanation of the gelling chamber (Step 16.1) disassembly. Using 
a razor blade, the top coverslip (Step 16.2, 16.3), then the spacer coverslips 
(Step 16.4) are removed. Excess gel is trimmed from the slide (Step 16.5). b. Foto 
examples of the gelling chamber disassembly and of the tissue hydrogel hybrid 
before and after trimming. c. Graphical explanation of the digestion setup. After 
removal of the gelling chamber and hydrogel trimming, the slide is moved onto a 
tray (Step 17.1) containing a humidified paper and a bottom parafilm piece on top 

of the humidified paper to avoid leakage of digestion solution into the humidified 
paper. Next, the digestion solution (red) is pipetted onto the specimen (Step 17.2) 
after which a second piece of parafilm (cyan) is carefully placed on top of the 
specimen (Step 17.3, 17.4) without introducing bubbles between the parafilm and 
the specimen to prevent evaporation of the digestion solution during incubation. 
The specimen is then moved into the oven for incubation. d. Foto examples of the 
incubation setup.
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Extended Data Fig. 4 | Tissue expansion and sample mounting. a. Graphical 
explanation of tissue expansion stage. After samples are removed from the 
digestion incubator and have cooled off, they are placed on a clean work surface 
(Step 19.1) and the parafilm cover is removed using a razor blade (Step 19.2). Next, 
the sample is separated from the slide with the help of a razor blade (Step 19.3) 
and loaded onto the razor blade with the help of a paintbrush (Step 19.4) to 
transfer the sample to the cell culture well (Step 19.5). Tissue expansion is 
then performed by carefully adding ddH2O to the sample (Step 20). b. Foto 
examples of critical handling steps during the tissue expansion stage. Note that 

larger samples can also be trimmed on the slide (Step 19.3, 19.4). c. Graphical 
explanation of the sample mounting stage. Expanded specimens (Step 22.1) are 
loaded onto a piece of aluminum foil with the help of a paintbrush (Step 22.2) and 
transferred (Step 22.3) to the coated imaging chamber into which the samples 
are transferred by holding the sample in place with the paintbrush while carefully 
and slowly pulling out the aluminum foil from underneath the sample (Step 22.4). 
The mounted samples (Step 22.5) are then transferred to the microscope for 
imaging (Step 22.6). d. Foto examples of critical handling steps during the sample 
mounting stage.
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